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MBI-300

INDIVIDUALIZATION OF DNA SOURCES BY STR ANALYSIS

1.0 BACKGROUND:

Once a DNA source has been detected, and identified as to
"source type' where applicable and feasible, it #&2cften
important to attribute the DNA sample to a par Emular
individual inasmuch as possible. Current DN ‘%echnology, in
the analysis of STR loci, offers 1nd1v1dua%§%btlon potential.
However, the individualization of a part' ar sample occurs
through a comparative process. This ess requires a DNA
profile from a ‘known’ sample to Whlig:t evidence sample
profile can be evaluated. Often t s ‘known’ sample

is identified through a search o ﬁb either SDIS, or
NDIS) database in cases where t pe p r of the
particular crime is orlglnall ﬁbn A samples are
collected from lﬂle;duals vualifying crimes
under Idaho code and are at STR loci for entry
intc and subseguent seaﬁb the DNA database,

2.0 SCOPE: \\Q)
© O «
To provide unifo E@} s&ééfof DNA samples to achieve high

guality data %<& interpretation.

{>
3.0 EQUI PMNTJQFAGERQS

As llsfgg in individual analytical procedures.
4.0 PRéaEDURE

See Flow Chart on following page.
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RECEIPT & DOCUMENTATION OF
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5.0 COMMENTS:

5.1 Careful scrutiny at each step will ensure insufficiencies
are identified, and compensated for where feasible, at the
earliest possible point (see BI-318 for specifics).
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BI-301

CODIS SAMPLE RECEIPT AND DNA TRACKER ENTRY

1.0 BACKGROUND:

The implementation of the Combined DNA Index System (CODIS)
in forensic DNA laboratories has provided an addxalonal tool
in assisting law enforcement agencies in solvi or linking
crimes that otherwise may not have resulted ;g\ he
identification of a suspect. It is import@éﬁ; however, that

samples entered inte the database be give unique
identifier, which does not include any: sonal or
identifying information, in order to ntain the
confidentiality of the individual. aboratory must
develop a method of identifier a nm that each
sample may be tracked and 1dent1§a

ed a ea§iter time, 1f the

need arises. \0 @ §Q/

Tdaho Statutes: Title 19, dure, Chapter 55

“The Idaho DNA Database t §§r9
*\i@c\é

ISP Forensic Blology4§ﬁ Qg?y/ r edure Manval, Appendix C
O

2.0 SCOPE: ‘(\ {é}

To provide a &$}h0€> €$§>acklng cffender database samples

submitted 5*2? and CODIS entry, while ensuring
individua \,%pnflden lty

3.0 EQUI;:@QIT /REAGENTS :

Computer Workstation with ISP Intranet Access

Barcode Equipment

Court Orders, Database Samples, and Report Forms
4.0 PROCEDURE:

4.1 SAMPLE RECEIPT:

4.1.1 Offender DNA samples and their corresponding DNA
Collection Report Forms received by the

Revision §
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laboratory are to be marked with the date of
receipt and the initials of the scientist who
received them. The sample and report form may be
malled to the laboratory separately; in the event
that a sample has not been received, the
submitting agency should be notified.

4.1.2 Where possible, compare the DNA sample card
information to that of the Collection Report Form
to ensure accuracy. Data for a sample may be
entered in absence of a DNA Collection@Report
form. Additionally, an IDOC# is noKﬁZ%cessary
for data entry into DNA Tracker, > it 1is
preferred. Contact necessary %ESE personnel or
search the corrections web31t
{www.corrections.state. ld U S %? or a number if one

has not been recorded. Collection Report
Form will be retained afK} 2§§Tracker data
entry. QO C)O
4.1.3 The offense liste [ th@%@ple card and/or
Collection Repqg?é%ust& 1ifying offense
75480

under Idaho Cod Qorder for the sample

to be entered<;htdQ§NA‘§ gacker and subsequently
CODIS/NDI;ES’ (3 ions website listed above
and/cr IL onsulted for more

:Lnform é\ Tfense listed is non-
qualifp: ear. The scientist relies, in
go d?} 062 e information provided by the
5 éé% &éy cy for entry into Tracker. It is
ot n y, nor is 1t the scilentist’s
Qé‘ esponsi ity, to verify the offense(s) of every
(Q Offender if the information provided by the

<2<$) submitting agency qualifies as listed.

4.1.4 Samples received in the laboratory that do not
have an associated gqualifying offense will not be
entered into DNA Tracker. The collection report
(if present) will be marked to indicate that the
sample is a non-qualifying offense and returned
to the submitting agency. If there is no
collection report, a copy of the sample card will
be made, marked in the same manner, and returned

CODIS Methods: BI~301
Page 4 of 67
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4.2 COURT

to the submitting agency. The sample({s) wilil
then be destroyed.

ORDER RECEIFT:

4

4.

4.3 DNA TRACKER PRE- ENTRY<%E

L2,

2.

.2.

1

Court order forms received by the laboratory are
to be marked with the date of receipt and the
initials of the scientist who received them.

The offense listed on the Court order fmst be a
qualifying offense under Idaho Code(ﬁ&—5506 in
order for the court order informa{} to be
entered into DNA Tracker. qga

If the offense on the courtésgder is not a
gqualifying offense, nc fur action will be
taken. The court order marked to

indicate it is a non- qg ,foense and
returned to the subm 1n g

@

4.3.1 Prior to da@en@y &any new sample or court

%

4.

@Q

3.

.3.

CODIS Methods:

Page 5 of 67

order, a¥ch is performed to

elimin €Ddu ()c ffender entry. Log on to
tabase program, located under
Ré b 1 ted d

the
Fo \Emc%pn G\/ISP Intranet.

xﬁggaupizba ffender search will be performed

3

4

ing th&:) ame’ field, followed by at least one
of the “ID’ fields to maximize the potential for
locating an offender. Note: the ‘DOBf field may
only be searched in combination with a name.

If ali of the searches return ‘No matches found’,
the data for the new sample or court order may be
entered as a ‘New Offender’ (see 4.4).

If a record(s) i1s returned that meets the
criteria, the data is examined and compared with
the new sample or court order received. If it is
determined that the Offender already exists in

BI~301
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DNA Tracker, the new sample or court order and
any additional Offender information will be
entered under the appropriate tabs for the
already existing Offender. Each sample received
for an offender will be assigned a unique barcode
number and will be retained in the laboratory
(see 4.4),

4.4 DNA TRACKER ENTRY:

9

4,4.1 Enter basic Offender information fru he court
order, sample card, and/or DNA Co%sgbtlon Report
form as follows: qga

1) For Offenders not currentaggﬁn Tracker, click
‘New Offender’ at the t f the screen and

fill in each of the a p faffe fields with the
Offender’s primary . Additional
information for O de dy in Tracker
may be entered Qgég ‘Edit Basic

Details’ tab thq} O er,
the

2) Verify all o ion 1s correct and
press the §§ve\éBuHE§Z)ln the top right corner
of the

3} Add anyiéhd kg% g&/ lias names, DOB’s, SSN's,
and catlion Numbers on the
apgﬁg ri \e a s tab (s} that become available

e new offender. Click the
;gg% after each entry.
4.4, xé%mer eaéE)offense and its associated information
<Q from the court order, sample card, and/or DNA
<2<$) Collection Report form as follows:

1y Click the ‘Offenses’ tab for the saved
offender.

2} Choose the appropriate offense from the pull
down menu and enter the corresponding
information into the remaining fields,

3} Verify the information is correct and press the

‘Save’ button in the top right corner of the
window., Multiple offenses for the same

CODIS Methods: BI-301
Page 6 of &7
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Offender must be entered and saved
individually.

4) Offense information may be updated/edited if
additional data is received at a later time
(e.g. when a sample arrives, fulfilling a court
order or an additional sample for the same
offense is received}. Under the ‘Offenses’
tab, click on the appropriate offense code
listed in the table of offenses. Enter the
appropriate information and click the ‘Save’

button. 9
O@

4.4.3 Enter Court Orders for an Offende&ﬁbs foellows:

%

1) Click the ‘Court Orders’ teéakor the saved
offender.

2) Enter the court order lS@S% nd received dates.
Note: the order recei Q§g will
automatically popul Kzéb sample history,
once a sample haséyarl hss fulfilling that
court order.

3y Click the ‘A &fer{% ﬁk and choose the
c

approprlate 0 fen ase from the pull

down: menu. \» ot an fenses in the pull down
list ar a{? sly entered in the
‘Offens ourt order must have an
ass in order to be entered;
thégy or€> th ffense information must be
@’to the court order.
4t§&3 formation is correct and click the

A ‘Sa &ton
{56 Cnce t court order has been entered it is

placed in the appropriate filing cabinet

{S§Q located in the CODIS office.

4.4.4 Enter samples for an Offender and print sample

CODIS Methods:

Page 7 of &7

barcodes as follows:

1)Click on the ‘Samples’ tab for the saved
Offender.

2)Enter the sample informaticn into the
appropriate fields, leaving the barcode field
blank (Tracker will automatically generate a

BI-301
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unique barcode number if the field is not
filled in).

3)If the submitting agency 1is not iisted in the
agency pull down menu, it may be added by
clicking on the ‘edit agencies’ button to the
right of the agency field.

4) If the sample received is pursuant to a
previously entered court order, click on the
‘Show Unfulfilied Court Orders’ link. <Click
the box next to the appropriate court order to
mark it as fulfilled by the samplqubing

entered.

5) Enter the number of barcode lab ‘E to be
printed. One label is to be ced on the DNA
sanmple card/folder, one on L collection

report, and one inserted 'é@ind the FTA card
envelope for placement QQ\ he FTA card at the
time of analysis.

6) Verify the 1nforma i ‘xsgt and click the
‘Save’ button. C de(i& 111
automatically p {b ﬁ%} g the sample
information.

7} Staple the Dﬁz Coksﬁ \S} Report (if present)
to the 1nsx§h <fh%;§;h sample folder and

barcode labels. The

attach éﬁ n{?
labeled é%? ard, with collection

rep aced in one of the filing
Qy ts in the CODIS office.
may be printed at a later time
\:ﬁ#? al samples, by clicking on the
app e sample from the ‘Samples’ tab or

{SS for mu ple samples, by using the ‘Batch
C§§b Samples” function at the top of the screen.
Qﬁ

CODIS Methods: BI-301
Page 8 of 67
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BI-302

CODIS SAMPLE DATA ENTRY AND UPLOAD

1.0 PBACKGROUND:

The implementatiocn of the Combined DNA Index Sysu%m (CCDIS)

in forensic DNA laboratories has provided an a lonal tocl
in assisting law enforcement agencies in solyAhg or linking
crimes that otherwise may not have resulte the

identification of a suspect. Accurate daé%)entry for upload
to NDIS {(Natiocnal DNA Index System) is‘QgBentlal.

It is the responsibility of the Fo 1c 1entlst to
generate profiles from conv1cted d/or forensic
samples, determine CODIS ellglb l evi other
scientist’s profiles, enter t Répfl into CODIS and
notify the CODIS Admlnlstra Qi@» ential problems
associated with their COD NA @to s. The CODIS Manager
is responsible, in part«SQO &g@ve the laboratory’s chief
point of contact for Q}CO unications, maintain
CODIS software updat y, update/add/remove CODIS
users, and upload fli%} IS.

CODIS and ND Procedures., Idaho currently
allows for to the following Indices: Cffender
ffender

DNA profiles e éﬁre (§§§;2 DIS will be done so according to

{convicte nidentified Human Remains (deduced
victim wn, unidentified person); Missing Persons (alleged
fathe ther, biological child/father/mother, sibling,

de d victim known, missing person, maternal/paternal
relative); Forensic Mixture; and Forensic {(known and
unknown) . Profiles entered into the Forensic Index include

both solved and unsolved cases in which the profile is
assocliated with a crime and believed to be attributable to
the putative perpetrator. Suspect reference samples and
profiles matching the victim({s) and/or any elimination
samples (e.g. consensual partner samples) may not be
entered,

Revision 9
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2.0 SCOPE:

To provide a mechanism to ensure accurate data entry for all
offender and forensic database samples

3.0 EQUIPMENT/REAGENTS:

CODIS Computer Workstation

Allele Tables and/or CMF files generated from i@?pie

analyses.
R\¥
CODIS Training Manual q52$
4.0 PROCEDURE: O
B &
4,1 SAMPLE DATA VERIFICATION: Qb

S¢S

4.1.1 Genotypic data (all e cafiﬁ)
accuracy and ver ﬁSb d
Review process e
form (Form. 306 T aa@b Yo

4.1.2 Forensic Zggéhlsf}ng<€§ggon/Unldentlfled Human
profiles for CODIS eligibility and
Index(x?d ( e@g on the CODIS entry form

Fox

4.1.3 A%@i <%lg%? hen 'STR Data Entry’ is used to
nter ual sample data (generally forensic
{gamples) (;Erlflcatlon of 1lst and 2nd 'reader' is
C§§b automatically achieved pricr to NDIS upload.

checked for

e CODIS/Casework
cn the appropriate
1 )214+BT, respectively).

4. §2 AMPLE DATA ENTRY 1IN CODIS:

4.2.1 Once sample data accuracy {(forensic and offender)
has been verified, data may be entered into the
CODIS database either by use of the 'STR Data
Entry' module to enter specimen ID/info and
allele calls for individual samples or by using
the 'Import' function for the entry of batches of
data contained in a .cmf (or egquivalent) file.
Refer to the CODIS Training Manual and course
documentation for specific steps in accomplishing
these tasks.

Revision 9
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4.2.2 A second 'read' must also be entered for the
individual samples through 'STR Data Entry'
This may be done by the analyst entering the
sample data, or by ancther analyst logging on and
entering the allelic data in the second read box.
If a single individual enters both reads, the
entire profile {i.e. all lcci) for the first read
must be entered prior to entering any data into
the second read. A 'check' indicates agreement
between readers at individual loci and
discrepancies in entry must be rectl%ggﬂ before

saving to SDIS. ~SS>
4.2.3 When using the "Import' functleagb he scilentist
will open the appropriate r egquivalent)
batch file select 'validate ort' This will
ensure that any typos or ifisdtngistencies (i.e.,
variant allele definitio e alencies) will be
identified prior to 1 mQy be corrected.
Once the batch flie dated for import
(corrections perf ary), "import' is
selected by the the process of
importing the b tc a into SDIS will
commence.
4,3 CODIS DATA UPLO£B> <:>
4,3.1 Prl (gsb ellglble samples to NDIS, a
\!% to be performed to identify any
ézﬁ& es at the state level. This is
yplc ne by running the ‘Autosearcher’
Q}‘ nction the software. See BI-303 for

(Q verification of any candidate matches identified
<2<$) during the autosearch.

4,3,2 There are various reasons that some samples
present at SDIS3 should not be uploaded to NDIS.
Prior to NDIS upload, these samples will be
selected in Specimen Manager and 'unmarked for
upload'. Generally speaking, an incremental
upload will be performed. In Specimen Manager,
"incremental upload' 1s checked on the 'upload'
pull-down menu and 'send upload' is selected.
The uplecad is sent to NDIS as a message
attachment via DNACOMM. If any ‘'candidate
matches' are ldentified at NDIS, a match message
will appear in DNACOMM and they will also be

Revision 9
CCDIS Methods: BI-302 8/10/09
Page 11 of 67 Issuing Authority: Quality Hanager




reflected in Match Manager. For hit verification
see BI=303.

5.0 COMMENTS:

5.1 Refer to CODIS Training Manual and course documentation
for more specifics if necessary.

5.2 The CODIS software is redundant and there is generally

more than one way to accomplish many tasks. Using a
mechanism other than that listed here is a table,
WO

5.3 The CODIS software is updated periodica §§ and any
necessary changes in procedure provi @ with new
updates supercedes those in proced é} written pricr to
update, 1f appropriate.

5.4 The sample history for convictél gboféi?der samples in
DNA Tracker will be updated ?iib dates of sample
analysis (in progress,

appropriate), date samp asqg t ced for testing,
and/or date profile ntq\ o CODIS., This is
accomplished for lndledu es under the ‘Samples’

tab for the Offen on the appropriate
sample and choo éﬁ ry Event’. Multiple
samples may be da the ‘Batch Samples’

function at screen The current
dlSpOSltloegb ﬁp \v' checked as appropriate for the

hlStory&JN
5.5 Ellg%%éf fo <2)proflles of unknown origin (i.e.
profilées not Hibchlng any of the known reference
Dles) identified in the course of casework analysis
st first be compared against the ‘staff’ index before
<2 entering the profile into the database. The ‘searcher’
function is used by hand entering the profile and
choosing the ‘staff’ index. This profile will not be
saved upon completion of the search and will need to be
entered as outlined above for storage in the database.

5.6 ‘Searcher’ is also used for performing cne-time
keyboard searches of forensic unknown profiles. When
performing a one-time search, the requesting agency
will be notified either verbally, or in writing in the
event of a negative search result. See BI=303 for
verification of candidate matches identified during the
one~time search,
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BI-303

CODIS DATABASE HIT VERIFICATION

1.0 BACKGROUND:

The implementation of the Combined DNA Index System (CODIS)
in forensic DNA laboratories has provided an additional tool
in assisting law enforcement agencies in solving or linking
crimes that otherwise may not have resulted in tlgg
identification of a suspect. This is accompli€§ad by the
electronic storage and maintenance of DNA pr es at the
local, state and national levels., Hits a btained when a
candidate match({es) 1s identified through database search
at any level. Hit verification involvéébévaluating the

candidate match to determine if it i true match and
verification cf CODIS offender sampéa»da where necessary
and possible. QO

NDIS CODIS Hit Disposition R @%u_ <g§%1rm an Interstate

Candidate Match - Operatlon rQ§§%5>

2.0 SCOPE: N
& c\ o

To provide a method &b fication to be performed

priocr to law enfoassmeni' e&} notlflcatlon of a database
hit to ensure rg&g y true, confirmed matches.

3.0 EQUIPMENT/RJ;@ %
CODIS \S Q)

NDIS P edure Manual CODIS Training Manual/documentation
DNA ker

A

Offender Database Sample({s)

Equipment /Reagents for STR Analysis

4.0 PROCEDURE:

4.1 MATCH VERIFICATION (Forensic):

4.1.1 For 'hits'/matches involving an ISP Forensic
Biclogy evidentiary sample {either case-to-case
or case—-to-offender and including one-time
keyboard searches) the primary responsibility for
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match verification follow-up and disposition lies
with the Idaho CODIS Administrator.

4.1.2 The CODIS Administrator or designee (typically
the case analyst) will first evaluate the
'Candidate Match' in Match Manager to determine
if there is a basis for exclusion and, therefore,
disposition as 'No Match'. A 'No Match'
disposition doesn't require further verification
or, where applicable, notification of the other
laboratory involved with the match. ng

4.1.3 If evaluation in Match Manager deggnstrates that
the candidate match consists o ntial high

stringency {e.g., exclusions butable to
different typing systems, z§§§éga v. Applied

Biosystems}, or possibly m rate stringency in
the event of a forensic g%z§§§or degraded

sample, the dlSpOSltl d from
'Candidate Match' to 1l the
verification pro lS In general,
for case-to-cas £§§: erlflcatlon will
consist of comm 1c3¢§b ween sclentists
regarding tha\'até\ e status, while case-
to~offend cally necessitate sample

veriflcatl e&b h, '¥ffender lab'.

‘{b\g \tus% the 'candidate match' has been

4.1.4 Once
re bg) Sposition is set accordingly
{ﬁb ch', 'Offender Hit', 'Forensic
\%lt' Ction Match’, ‘Investigative
Q§,Informat ', etc.) and ‘Investigations Aided’

{Q filled in as appropriate and as outlined in the
<2{$) NDIS ‘CODIS Hit Disposition Reporting’ procedure.
4.1.5 If verification results in a 'hit', a hit report
ig issued by the case analyst. & copy of the hit
report, along with the CODIS match report, is
filed in the CODIS file. The original hit report
and a copy of the CODIS match report are placed
in the associated case file. The appropriate law
enforcement agency is notified of the 'hit'. If
the law enforcement agency submits a sample from
the identified offender, appropriate analysis and
issuance of a supplemental report will be
performed as in 4.2.5,
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4.2 MATCH VERIFICATION (Offender):

4.2.1 For 'hits'/matches involving an ISP Forensic

4

%

.2,

2.

@Q

2.

CORIS Methods:

Page 15 of 67

genc
<§t umbpri

Biology convicted offender sample the primary
responsibility for match verification follow-up
lies with the CODIS Administrator for the
laboratory with the forensic (evidentiary)
gample. However, the initial evaluayégh in Match
Manager (see 4.1.2-4} and AFIS samplE
verification (see 4.2.2) will be “ﬁttlated as
soon as feasible once a verifigafion request has
been received from the forenstg%aaboratory

Once a potential match ha confirmed and a
verification regquest re he associated
offender sample folde trleved from the
gsecure file cabinet CI for an AFIS
search of the thu 1nU§§' 1fy identification

of the offender u ation will be filed
in the CODIS fl

Following <§y ion of the thumbprint,
re- analysl <§/ nder sample will be
perfor ate (i.e., if duplicate
ana%ﬁ@ ha@s a dy been performed either as a
QC <§9 s the result of a duplicate
cEy) l}ﬁﬁé ﬁépls will not be repeated) prior to

&ication. In situations where a

was not received with the DNA sample,

or is of insufficient quality for verification, a
notation will be made and re-analysis for
confirmation may proceed. The forensic
laborateory {or law enforcement agency for Idaho

cases) will be notified that the Offender could
not be verified through thumbprint confirmation.

Following sample verification (AFIS and re-
analysis as appropriate} the forensic case
laboratory, in the case of an interstate hit, or
submitting law enforcement agency will be
notified of the confirmed hit. Laboratory
notification may be made verbally and relevant
documentation will be provided to the forensic
case laboratory as requested. In Idaho, initial
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notification as well as the request for a new DNA
sample from the identified offender, may be made
verbally. However, written notification and a
formal request for a new DNA sample, in the form
of a hit report, will be sent to the appropriate
law enforcement agency.

4.2.5 Por intrastate offender hits (Idaho}, where
possible, a newly obtained DNA sample from the
offender will be analyzed with all deliberate
speed. The analysis of the forensic ple may
also be repeated, though this is no equired. A
supplemental report will be issue@fﬁelineating
the match in the usual manner t%fﬁ., same
treatment as for matching sugeg sample
submitted with case evidench\

4.2.6 The sample history in D%Sg?r r will be updated
to reflect the date t i&:fba A§9nfirmed for the
offendexr sample. QO
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I-310

CODIS SAMPLE REMOVAL

1.0 BACKGRQUND :

Participation in the National DNA database, in accordance with
the DNA Analysis Backlog Elimination Act of 2000, egsitates
provisions for DNA profile expungement in the evq§p that a
qualifying offender’s conviction is overturned dditionally,
the Idaho DNA Database Act of 1996 addressesg?&hrt granted
expungement requests (I.C. $19-5513). Rem of DNA profile
data and/or destruction of biological sa s obtained from
Convicted Offenders may be necessary as €Dre ult of conviction
reversal or sample collectlon/submls%SR W;r

oflle data from

)} databases in
ffender’s conviction

1l include the removal of
ratory documentation and
rom which the offender

Expungement is defined as the rem Qé:ﬂ
local (LDIS), state (SDIS} and '\Q?lo 2 (
response to a court order ov {Drn t
of a qualifying offense.

identifying information fﬁSég
destruction of the biol

database DNA profile v% ,&

Administrative rem d as the destruction of a DNA
sample and remo @?& rds relating to that sample.

Examples for w {:éai ratlve removal may be warranted
include, but e no l§§éled to, the collection of a sample from
rf

a non-gualifying offen or the notification by the collection
agency t removal is warranted. Generally, the determination
that sample does not qualify for inclusion in the database

occcurs¥prior to entry of the profile into DNA Tracker and
subsequently CODIS (see BI=301)}; however, there may be instances
when the collection agency provides notification of an error
after the profile has been generated. In these circumstances,
the profile will be removed from the local, state, and national
databases as part of the administrative removal,

NDIS Expunge a DNA Profile - Operational Procedures

Idaho Statutes: Title 19, Criminal Procedure, Chapter 55 “The
Idaho DNA Database Act of 1896”
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By

2.0 SCOPE:

To provide a protocol for CODIS sample expungement and
administrative removal that protects an individual’s rights to
privacy and maintains the integrity of the Idaho DNA database
program. All procedures will be documented on the CODIS Sample
Removal Checklist (Form 310-BI).

3.0 EQUIPMENT/REAGENTS:

®6
CODIS Workstation ‘
DNA Tracker Database {é
%Q
4.0 PROCEDURE:
oot ot .\0

4.1 EXPUNGEMENT {}

@

Prior to removal of any DNA pr<€;h &Sg source
identification, or bzologlca am gz& ruction, the CODIS

Administrator or designee Q%b Egb f the request for
expungement is accompan =8 @19{1 court order that

meets the requirements k?té&Séa C. §19-5513, Z2) that
the offender has no {;%g offense{s) and 3) the
identification of é§> a{%EQA database sample where
possible.

4.1.1 A sea §Q}of dﬁﬁ, §%Cker is performed to establish

whet Speleled sample has been received
in €h ‘<§ y and if so, whether or not a DNA
g&flle &en generated and/or entered into CODIS.
%§é%fthe sample has been received in the laboratory, a
Q criminal history check in ILETS will be performed to
ensure that the ocffense for which the expungement is
requested is the only qualifying offense. If the
Offender has a separate qualifying offense, the sample

will not be expunged and a copy of the criminal
history check will be retained for documentation.

4.1.3 The assoclated offender sample folder will be
retrieved from the secure file cabinet and taken to
BCI for an AFIS search of the thumbprint to verify
identification of the offender. The absence of a
thumbprint or a poor quality thumbprint does not
preclude the sample expungement from proceeding.
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4.1.4 The offender record will be removed from DNA Tracker
and a sample removal report generated.

4.1.5 The DNA profile, if applicable, will be deleted from
CODIS, followed by an uplcad to NDIS for remcval at
that level. A written notification of the expungement
will be made to the NDIS Custcdian and a request for
verification of deleticon at the national level.

4.1.6 The original DNA Collection Report received with the
sample (or a copy of the sample folder n no report
is received) will be marked expunged; (@ ong with the
scientist’s initials and date of e XY gement

4.1.7 The DNA sample will be destroyeefé%d witnessed by a
second scilentist. Qp

4.1.8 Administrative paperwork é&gﬁm@ing the event will be
retained in the CODIS f perwork may contain
some administrative 1mzprm £Hon ut the
sample/individual 1&\ ed from and will
include the follgcgﬁg gticable: the court
order/request £ Xp criminal history check
and thumbprlnt rifs) atddir, DNA Tracker sample
removal rep @ a‘@ gtion report(s), NDIS
correspond ample removal checklist, and
copies yxs zéép ndence with the reqguesting
party. e>

4.1.9 An e§p ? Otlflcathn letter (or letter
e

&\ 1cat expungement did not occur), the DNA
llectlon port or folder copy, and a copy of the
CODIS sample removal checklist will be sent to the

<2{$> requesting party.

4.2 ADMINSTRATIVE REMOVAL

Prior to removal of any DNA profile data, source
identification, or biological sample destruction, the CODIS
Administrator or designee will verify: 1) the reqguest for
administrative removal is in writing from the collecting
agency and includes a description of the error resulting in
the removal request and 2) that the offender has no other
qualifying offense(s).

Removal resulting from an entry error on the part of ISP
Forensic Biology staff does not require a written request;

Revisicn 9
CODIS Methods : BI-310 8/10/09
Page 1% of 67 Tssuing BAuthority: Quality Manager




although, the nature of the error should be documented.
Reguests for administrative removal from a party other than
the collecting agency or due to biology staff error will be
referred to ISP legal staff for a determination of the
appropriate action to be taken,

4.2.1 A search of DNA Tracker is performed to establish

2.

.2

.2,

2.

2

.3

4

5

whether or not the specified sample has been received
in the laboratory and if so, whether or not a DNA
profile has been generated and/or entered into CCDIS.

If the sample has been received in t €gaaboratory, a
criminal history check in ILETS wil e performed to
ensure that the offense for whicp @he administrative
removal is requested is the on E?ualifying offense.
If the Offender has a separat ualifying offense, the
sample will not be removed a,copy of the criminal
history check will be rete§}ed<§$k documentation.

and a sample remova{é@ép ated.

O§ S

The offender record wt;% QQS;% q%b from DNA Tracker
g

Q)

The DNA profile, Yf %Egﬁ

<j§3e, will be deleted from
CoDIs, follow%%, y. AR U d to NDIS for removal at
that level.é\, @6 0

s

The original a ection Report recelved with the
sample T (@op the sample folder when no report
i bs{veQ§>w' be marked expunged, along with the

is
SCigtj\QSQ\S%@tials and date of removal.

4.2. a%ﬁe DNA sample will be destroyed and witnessed by a
C§Q second scientist.

<2.2.7 Administrative paperwork documenting the event will

CODIS Methods
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8

be retained in the CODIS file. The paperwork may
contain some administrative informatiocn about the
sample/individual it was collected from and will
include the following, as applicable: the request for
administrative removal, criminal history check, DNA
Tracker sample removal report, CODIS deletion

report (s), CODIS sample removal checklist, and copies
of any correspondence with the collection agency.

A sample removal notification letter (or letter
indicating why removal did not occur), the DNA
collection report or folder copy, and a copy of the
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CODIS sample removal checklist will be sent to the

reguesting party, or submitting agency in the event of
an internal entry error.

5.0 COMMENTS :

5.1 An Offender cannot be deleted from DNA Tracker if there are
any samples and/or court orders associated with the offender.

5.2 A sample cannct be expunged or deleted from DN CPracker if
there are qualifying offenses associated wiE§$ e Offender.

5.3 The ‘Delete Sample’ function will be us Qgé remove a sample
from DNA Tracker for an Administrative oval.
2
5.4 The ‘Expunge Sample’ function will ﬁh used to remove a sample
from DNA Tracker for an Expungeme§gg <Q
O

®<< \O Q/é&
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1.0

BI-312

EXTRACTION PROTQOCQLS FOR PCR DNA TYPING TESTS

BACKGROUND :

Many methods exist to obtain DNA, suitable for amplification,
from a variety of sources. It has become increasingly important
to streamline the extraction process through automation. A
variety of extraction methods and robotics systemsq%%ve become
available for the successful extraction and dow'ébream processing
of known database DNA samples, using both blogd ~and buccal
collection methods. The Promega DNA IQ Ext ion System and the
Beckman Coulter Biomek 3000 robotic worksteﬁlon are both examples
of systems that have proven successful lﬁSt e forensic community.

Comey, CT et al. “DNA Extraction St egm@%\for Amplified
Fragment Length Polymorphism AnalyQ ”C)@ (&SCJ,, Vol. 39,
1994, pp. 1254-1269. wss
Cb
> w?
McLaren, B et al. “Automatim@i@he ystem on the Biomek

3000 Laboratory Automatlondg

ks qE) Profiles in DNA, 2006
Vol., 9(1y: 11-13

Supports Using the ev1ce Profiles in DNA, 2005
Vol. 8(2}: e>

DNA I0Q System—ﬁé%aQE§?’iigékocol Technical Bulletin (revision
date 4/086) xé%omega. C)

Terepa, A et al. “Hi Ca% Proce531ng of Samples on Solid
ch\

‘\
AutomatﬁiﬁpNA IQ System Protocol for the Beckman Coulter Biomek
3000, ical Bulletin (revision 6/09), Promega.
SCOPE :

To provide appropriate protocols for the extraction of database
sample DNA, both manual and automated, suitable for PCR
amplification and subsequent analyses.

EQUIPMENT:

Pipettes and tips
Harris Punch
BSD600-Duet Semi-Automated Sample Punch Instrument w/ Scanner
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96-well Reaction Plate

Microhmp Tubes

1.5m¢ microcentrifuge Tubes (1.5mt tubes)

65°C Oven

SlicPrep Device

Adhesive Foll Seal

70°C Water Bath

Centrifuge with Swinging Plate Rotor

Biomek 3000 Robotics System with MagnaBot 96 Magnetic Separation
Device, 1/4 Inch Foam Spacer, Variomag Teleshak&%pand Heating

Block XE)
Reagent Reservoirs 6\
2.2m¢ Square-Well, Deep Well Plate qszt
1.2 m¢{ Round-Well, Deep Well Plate O

N
4.0 REAGENTS: QQ(O *
N

FTA Purification Reagent %O OQ &
PCR TE (TE, 10mM Tris-HCl; 0.1mM BP A,\'gﬁ 8%&)
DNA 1Q System Reagents \\C) %) <(/
99% Isopropyl Alcohol @) (Q @
95-100% Ethanol Q x<Q N)

1M Dithiothreitol (DT o &~
ithiothreitol (DTT) (5\ \ O

f—

0O
5.0 DNA EXTRACTION PEUDCEINJRﬁﬁ?: <§Sb <Z::>
O {S) AK
5.1 FTA EXTRACTION@ I{/%KTABASE SAMPLES :
A\

M
SO
Note: Sincecghe KA rdmains bound to the FTA card, regqular,
no x%ilte i te tips may be used throughout and a
s e tip m be used for each reagent. A multi-

3 annel pipettor and 96-well reaction plate may be used
<2§ or larger sample batches.

5.1.1 Remove 1-3 “punches" from the FTA card using a 1.z2mm
Harris punch {(this is accomplished by placing punch
firmly on card and twisting 1/2 turn clockwise and 1/2
turn counterclockwise). Eject/punch sample(s} into
microAmp tube(s)/plate. Alternatively, the BSD puncher
may be used to punch 1 2mm punch directly into the
plate (see 5.2.1).

5.1.2 Add 150u¢ FTA reagent to microAmp tube(s)/plate, gently
mix and incubate at RT for ~5 minutes.

5.1.3 Remove and discard FTA reagent from sample(s).
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5.1.4 Repeat 5.1.2-5.1.3 twice.

5.1.5 Add 150pt! TE to microamp tube(s)/plate, gently mix and
incubate at RT for ~5 minutes.

5.1.6 Remove and discard TE from sample{s).
5.1.7 Repeat 5.1.5-5.1.6 twice.

5.1.8 Make sure the punch is at the bottom of microlAmp
tube (s) /plate, using a sterile pipetta\ if
necessary. Place tubes/plate, uncowv ¥ed in 65°C oven

for 22 hours. %Q
5.1.9 Proceed to PCR Amplification (s%&’BI'&.‘SizG).
5.2 AUTOMATED DNA IQ EXTRACTION FROM @DI@MMASE SAMPLES

5.2.1 SAMPLE PUNCHING USING aggé %E§L§QOQ§;§ETT
. 0 @

5.2.1.1 Fill outq@}BSé?Bi ?@t Load Sheet on the
‘BSD Load Shedd WD of the Database
workshgﬁtswsan (Form 312-BI}. Print a
copg For e @h record. Choose the 'BSD
Inpat Q@é’%{a

.<§3rn2$9 orresponds to the Load Sheet
é$>ian? at entered. Delete any unused
O el

ing sure to keep ‘End File’ as the
O$\ 0 st 1., Perform a ‘Save As’ of the

w

s

and ensure the information is

Xé\ eet to disc (e.g. USB drive) for
S sequent transfer to the BSD60C puncher.
(fb The document must be saved as a .txt file,
{S) Save the template as samples are
<2 automatically populated on the other tabs for

subsequent processing steps.

Note: The last two columns of the plate
should be left empty for control placement in
subsequent steps. This allows for 78
samples, an extraction controcl, and a reagent
blank to be tested per plate.

5.2.1.2 Ensure the BSD tray table is adjusted
properly by placing the appropriate plates in
both positions and adjusting the height, as
necessary. The bottom of the chute should be
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~2mm from the top of the plates, measured at
each corner.

5.2.1.3 Turn on the BSD puncher and computer and plug

5.2.1.4

5.2.1.5

5.2.1.7

Database Analytical Methods

Page 25 of &7

in the air/pressure pump. Make sure water
is present in both filter bottles (~50-
100ml). Double click the ‘BSD Duet Main
Menu’ icon and login using the appropriate
user name and password.

Choose Configure System and op the Files
tab. Ensure that File Input. selected from

the Sample Number Mode dr wn list. Click
the Browse button and e your saved
input file te £ill i Input File Name
box. Click Save an éﬁ

Note: Using the i <§§le option only
allows for a to be punched at a
time. To pu plates, the process
must be r 1c?ed h new set of

pots and click Continue.
Wh ro edQ select test group to punch,
highli A%%} vailable Tests and click

i eck the box next to Input

,cgan
QD Fi R\tst d check the samples box on the

tQQ ress Continue. This test file will
n of the 3.2mm spots {(verify before

\:>b ning) If punching for FTA extraction
SR '

t umber and size of punches will need to
be changed under the Edit Test Sequences
option prior to beginning.

Place the appropriate plate into position 1
of the BSD tray table with well Al located
in the upper left corner. Click Continue to
begin punching. When using the SlicPrep 96
Device, remove the white collar, push the
basket down intoc the plate, and set the
collar aside before processing.

Scan the sample barcode using the scanner
attached to the BSD and place the card under
the card clamps on top of the instrument.

Use the light guide dots to properly position
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5.2.1.8

5.2.2 SLICPREP

5.2.2.1

5.2.2.2

5.2.2.3

the card for punching. Press the foot switch
when ready to punch or use the delay switch
for automatic punching. Repeat untll all
samples have been punched.

Note: The scanned barcode must match that on
the input file or the instrument will not
punch the card.

Remove the plate and proceed to SlicPrep pre-
processing (see 5.2.2}) or FTA &%ﬁractlon (sece

5.1).

Ny
PRE-PROCESSING %Q
Add 400ul DNA IQ Lys%gsguffer with DTT (see

5.2.3.1) to each we of the device plate,
Seal the top of tkébpl with a foll seal

and place into QGO" r bath for 15-60
min. @ \ é
0 e &

1l, raise the filter
white collar back onto
¥ng it under the basket and
ts on the device.

Without

basket agz plﬁgb
the deﬁgb :

ali nghgq§be
ght.k55§<‘§ device at 1500 x g for 5 min.

g plate rotor. Remove and
e collar and filter basket upon

QQm%J%Qon of centrifugation,.

v

2.4 PﬁE}eed to DNA IQ0 Extration on the Biomek

3000 (see 5.2.4).

SSESB DNA IQ REAGENT PREPARATION

5.2.3.1

Database Bnalytical Methods
Page 26 of 67

When opening a new DNA IQ kit, add 1.5mi 1M
DTT to the bottle of Lysis Buffer (lul
DTT/100ul iysis buffer) and mix. Mark the
bottle with initials and the date the DTT was
added. The ‘activated’ Lysis buffer may be
used for up to 2 months following DTT
addition. Alternatively, the lysis buffer
may be prepared as needed based on the number
of samples to be processed,
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5.2.3.2 Prepare the new wash buffer (70ml 2X bottle)
by diluting with 3bml Isopropyl Alcchol and
35ml Ethanol for a final 1X concentration.
Mark the bottle with initials and the date of
alcohol addition. The 1X wash buffer may be
used for a periocd of 1 month after
‘activation’. Alternatively, the wash buffer
may be prepared as needed based on the number
of samples to be processed.

5.2.3.3 Prepare/aliquot each of the DNAZIQ reagents
at the time of use, based on following
calculations and reservoir<§gﬁltlons
{instructions listed in &K&" ‘Reagents for
Solid Support’ commenpib ndow) :

1l: Elution Buffer :<$§b 1 + {(#samples x

100ul) K

Empty ,S'

3: 1X Wash Bu er = 5§%; (#samples x
0.3ml) QD

4: Lysis {W 1 5ml + (#samples =z
0.1ml
Lysﬁq’\'@ Bu@ DTT + Resin = [860ul +

5:
nggém ul)lysis] + [L40ul +

eg ,x Yiul)resin]
\éS)EQ5§9<2§§&'

W]

5.2. DNA Q@hXT T SING THE BIOMEK 3000 ROBOTICS
SYS?%M
é&. 4. T&E) on the Biomek 3000, computer, and Watlow
(Q heater, Make sure that the heater is set to
<$) 85°C and that the shaker electrical box dial
<2 is turned to the red at the far left stop.

5.2.4.2 Check the teleshaker connection by choosing
start > programs > teleshaker v.1.2. 1In the
test program window, choose options >
interface > com 2 and click Ok. Select file
> connect.

5.2,4.3 Open the Biomek Software and choose the ‘All
Others Method’.
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5.2.4.4

&
Q‘OQ

5.2.4.6

5.2.4.7

Database Analytical Methods :

Page 28 of 67

Set up the Biomek 3000 deck as follows
{outlined in the ‘Tools & Labware for Solid
Support Method’ comments window}:

Rack 1 (Al): Tool rack with MP200 (1)and
gripper (3)

ML1 (A2): P250 barrier pipette tips

ML2 (A3)}: P250 and/or Axygen 165ul barrier
pipette tips (up to 48 samples)

MI,3 (Ad4): P250 and/or Axygen 165ul barrier
pipette tips (up to 8& samples)

ML4 (A5}: P250 and/or Axygen ul barrier
pipette tips {up 9 96 samples)

P6 (A6): Heating system QD

Pi (Bl): PCR plate and

P2 (BZ2): empty

P3 {B3): Reservoir (ggﬁe and reservoirs with
reagents \

F4 (B4): Pre-p 6@%@%} square-well plate

PS5 {B5): Deep 1 ate stacked on the
M Qé &

B7 (B6): J,orr@ T @haker

xgb
Note: \g%e (Qf tip boxes will depend on
the Wk <§§ les to be extracted. The
only extract full cclumns on

the first box {(ML1).

1n§%}u Q%f
e using the Axygen tips, do not
se.é&@m

5. 26\5@?1(: Qe green run instrument arrow button

in the run. When prompted, enter the
er of columns to be extracted, choose 0
for solid support method, and either 50ul, or
100ul for elution volume. The 50ul volume
may be preferable for lower concentration
samples. Verify the reagent and deck layout
and click ok.

When the run has finished remove and seal the
PCR/elution plate. Discard the deep-well
plates, remaining buffer, and pipette tips.
Clean the reservoirs between runs.

At the completion of all runs for the day,
wipe down the deck with 10% bleach or
Dispatch solution. Tools may also be cleaned
with 70% FEthanol if necessary.
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6.0

5.2.4.8 Proceed to realtime PCR (BI-=314) for
gquantification of the purified DNA obtained
in 5.2.4.6.

DNA EXTRACTS:

6.1 After a plate of samples has been extracted and during
subsequent analyses {(e.g. quantification and amplification),
the DNA extracts may be stored sealed with foil at 4°C. For
longer storage periods, the extracts should be zen at
approximately —-20°C. These extracts are in—p{\ ess work

product during this stage(s). <§
=
6.2 Any extract remaining, following the sugc sful completion of
analysis and data review, will be discgarded.

<>

\Q Q*
Comments: Q O &

O §

7.1 A reagent blank shall be ca éﬁ%ﬁ gﬁr 11 extraction steps
to check the purity of th ggéﬁs \hg used. There need
only be one reagent blank xé@tr ion plate, but the
analyst may choose to néb addﬁELQD blanks on a given plate.

O

7.2 These procedures ma@oe%@é OQ blood or buccal samples on
FTA paper. &

7.3 The DNA IQ r B@ﬁ QESbhoroughly mixed/resuspended prior to
allquotlng 0{\ %

7.4 The fina%?élutlon (Slume attained on the Biomek 3000 will be
~8-10 ess than the volume chosen, due to evaporation during

th2?{§§) essing.

7.5 The Biomek 3000 performance verification color plate {Form
4728-BT) is run by choosing the ‘Color Plate/Performance Check’
method in the Biomek Software. Deck set up and dye
preparation is described in the ‘Instrument Setup’ step and
the ‘Deck Setup Instructions’ comment window.

7.6 The DNA IQ extraction procedure may be performed manually, if
necessary, following the procedure outlined in the DNA IQ
System-Database Protocol, Technical Bulletin (revision date
4/06). This procedure follows the same steps as performed on
the Biomek 3000,
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BI-314

DNA QUANTIFICATION:; REAL-TIME PCR

1.0 BACKGROUND:

DNA methodologies that employ the PCR, such as STR analysis,
necessitate consistent quantification of human DNA obtain
optimum data. .

p A\O

"Developmental Validation of the Quantifilermg52§l -Time PCR Kits
for the Quantification of Human NuclearDNAcC})[\3 lesg, " Green, R.5L.,
et al, Journal of Forensic Science, Vol 4, 809-825.

“Improving Efficiency of a Small Foren DQ§§paboratory
Validation of Robotic Assays and Ev Awlcrocaplllary Array

Device,” Crouse, C., et al, Croat Mg . 46, No. 4, pp.
563-577. \C)"

@ @
Quantifiler™ Kits (Quantliggz A Quantification Kit and
Quantifiler™ Y Human Mal@b’ A nt€§10ation Kit) User’s Manual,

Applied Biosystems. (‘O \\®

7500/7500 Fast Rea}_b{}me’égg@tems Maintenance Guide, Applied
Biosystems. o <>
*:$>'{§<> \Y%
2.0 SCOPE: * \) Q)

To pIOVLdeqs‘rellabifag%thod for the consistent quantification of
variable ounts of human DNA isolated from database samples,

QK

3.0 EQUIPMENT/REAGENTS:

ABI 7500/Computer 96-well Reaction Plate

ABI 7500 SDS Software 96-well Reaction Plate Base
Pipettes and Tips Optical Adhesive Covers

Reserveir {optional) Centrifuge (optional)
Quantifiler Human Kit Microcentrifuge Tubes/Strip Tubes
20 pg/m¢ Glycogen {optional) PCR-TE
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4.0 PROCEDURE:
4.1 PREPARATION OF DNA STANDARDS:

4.1.1 Label 8 sterile microfuge tubes, or strip tubes A
through H or 1-8.

4.1.2 Dispense 30ut (or ad}usted amount according to the kit
OC results: Form 419-0C) of PCR-TE into tube A (Std.
1) and 20pt¢ of PCR-TE into tubes B-H (Std. 2-8).

4.1.3 Mix the Quantifiler Human DNA StandardSé?oroughly by
vortexing 3-5 seconds. Transfer 10p<4to tube A (Std.
1). Mix the dilution thoroughly. qb

4.1.4 Prepare Std. 2-8 via a serial ‘ utlon by mixing and

subsequent 10p! transfers f tubes A through H. The
dilution series consists qéé 7, 5.56, 1.85,
0.62, 0.21, 0.068, and 0 &respectlvely

4.2 REACTION PREPARATION: Q &

0 <
4.2.1 Determine the numbéz £§Sg to be quantified
{including, at s of DNA standards).

4.2.2 Finish flllln ou 0 Load Sheet on the Database

h
worksheet <§h <§§§§/ 312-BI) Print a copy for the
th

case r VI500 Plate Document’ tab and
ensu 1on is correct and corresponds to the
Loa §:§§V atlon Perform a ‘Save As’ of the
e Do <§)Worksheet to disc (e.g. USB drive) for
sequent nsfer to the ABI 7500. The document must

c§$§% saved as a .txt file.

4<% 3 Calculate the volume of reaction components needed,
based upon the number of samples to be quantified and
adding 2 or 3 reactions to compensate for loss and
variability due to pipetting. The following are the
volumes needed per reaction.

Quantifiler PCR Reaction Mix 12.5ut¢
Quantifiler Human Primer Mix 10.5p¢

Note: The volume of reaction components necessary to
prepare the Master Mix will be automatically
calculated upon Load Sheet data entry.
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4.2.4 Thaw the primer mix and vortex 3-5 seconds. Pulse-spin
prior to opening the tube, Mix the PCR Reaction Mix by
gently swirling the bottle prior to use.

4.2.5 Place a 96-well reaction plate into a base, being careful
not to touch the top or individual wells. Do not place
the plate directly onto the counter or any surface other
than its base or the ABI 7500 thermal blo%gb

4.2.6 Prepare the Master Mix by pipetting t ‘}equired volumes

of primer and reaction mixes into @ppropriately sized
microcentrifuge tube or reservoirtb iXx thoroughly and

pulse spin if mixing in a tube. Q}

4.2,7 Carefully pipet 23p¢ of the§§§@ Q§§§er Mix in%tc the

bottom of each reaction w{% ‘Blowing-out’
the pipette is not reco 1d splashing and/or

bubbles in the well. @ §Q/

4.2.8 Add 2pt of samplecﬁ?stéﬁ%@aﬁ{ the appropriate

reaction well ég ef o avolid bubbles as much as
possible. 0
4.2.9 Seal the r Q3Fb<z§e with an Optical Adhesive Cover.

Proceed é?}

‘\
4.3 RUNNING ,&E mh&?&

rn on the 7500 computer and login with the appropriate
K user name and password. After the computer has
<2 completely started up, power on the 7500 instrument,
allowing it to warm up at least ~30 seconds. Launch the
ABI 7500 SDS Software.

4.3.2 Open the instrument tray by pushing on the tray door.
Place the plate into the tray holder so that well Al is
in the upper-left corner and the notched corner of the
plate is in the upper-right corner.

4.3.3 Close the instrument tray by gently pushing the right
side of the tray door.
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4.3.4 In the SDS software, select File>New and choose Absolute
Quantitation for Assay, 96-Well Clear for Container, and
Quantifiler Human Database for Template.

4.3.5 Import the previously saved plate document by selecting
File>Import Sample Set-Up. Browse to locate the saved
.txt file and choose OK.

4.3.6 Review the plate document to ensure the appropriate
detectors and tasks have been applied to each sample.
Change the task for any unused wells to in View>Well
Inspector or by highlighting and doubl icking on a
well(s). Make any other changes, as Cessary. BSelect
the Instrument tab and review the Hérmal cycler
conditions [Stage 1: 1 cycle, é; 0:00 min.; Stage 2:
40 cycles, 95°C, 00:15 min, 60° 00 min.; 25pt sample
volume; 9600 emulation; Data {ﬁ lection: Stage 2, Step

2 (60.061:00)] \Q Q
O O &

Note: Detectors are cre gSShe initial
instrument sets déé i usage Refer to the
Quantlfllereng Us\ ual (page 2-11) for
instructions %f#?cmtectors if needed.

4.3.7 Save the pla {gﬁéﬂ <:§ .sds file with the
t@\

approprlate

4.3.8 Under tgésghs ;ﬂ@&tab click Start to begin the run.

When pleted, proceed to 4.4.

4.4 ANALY \é.ND RESUQS

gqféb Open the plate document to be analyzed.

4.4.2 Select Analysis>Analysis Settings and verify the
settings are set as follows: All for Detector, Manual
Ct, 0.200000 for Threshold, Manual Baseline, 3 for
Baseline Start {cycle), and 15 for Baseline End {(cycle).
Click OK.

4.4.3 Select Analysis>Analyze.

4.4.4 In the Results tab, select the Standard Curve tab and
choose Quantifiler Human as the detector. Review the
data for inconsistencies from the following:
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An R? value of >0.99 indicates a close fit between the
standard curve regression line and the individual Cp
data points of quantification standard reactions.

An R® value of <0.98 needs further analysis of the
standard curve for problems. Refer to the Quantifiler
Kits User’s Manual (page 5-6) for troubleshocoting
guidelines.

The slope should fall within the typical slope range of
-2.9 to -3.3. A slope of -3.3 indicatescgbo%
amplification efficiency. O

R\

4.4.5 Select the Amplification Plot tab i@ the Results tab)
and choose either the Quantifile?g man, or the IPC
detector. Ensure the Threshol set to 0.20 before

proceeding (Note: the thresh ba will be green if the
data has been analyzed and \gnalysis is needed) .
Highlight the sampie (s} n the table to view

the associated plot(s). Qggé g§¥§g§&plots for both

detectors for ampllfL\ ion@and inconsistencies.

4.4.6 Select the Compo <2t Esgé‘{g§> the Results tab. The
halogen lamp m a\ ent if the dye signal
lines contail pear wavy/unstable and/or if
the Rox va éé;? roaching or has fallen below

e

500. See it is important to use the
same sa time.
4.4.7 In t@e RQQI b, select the Report tab and highlight
sam f interest to view the results. Review
e Qty col to determine the amount of DNA present in

cach sample. Review the Internal Positive Control (IPC)

<2{$> ¢y value for each sample. It should fall within a range
of 20-30. If the value is >30 for a particular sample,
there may be an indication of inhibition.

4.4.8 Export the report. Within the report tab, select
Tools>Report Settings and check the appropriate boxes to
be displayed in the report and click OK. Print a copy
of the Standard Curve for the batch record. Select
File>Export to export the report (e.g. to USB drive) as
a tab-delimited text file,

4.4.9 Import the tab-delimited text file into the 7500 Raw
Data tab of the Database Excel worksheet/template.
Choose the 7500 Results tab and review the imported
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data. Delete any unused wells from the sheet. Adjust
values in the final concentration and ul Sample for
dilution columns. Print a copy of the results sheet for
the batch record.

5.0 COMMENTS:

5.1 Refer to the Quantifiler Kits User’s Manual for specific
thermal cycler conditions, additional user information, and
troubleshooting guidelines. S

5.2 If the Component Dye signals appear unstabl Q%d/or Rox
values approach 500, the Halogen Lamp may & checked
manually to determine if replacement i eded. Place the
Green Calibration Tray in the b1°°k'.c§ ect Instrument >
Calibrate and set the exposure time A9 4096ms, lamp control
to Max, and select Filter A. Cll%% shot and chserve
results. Expected results shoui?s Egt of red
fluorescence displayed in all nﬁ% k of fluorescence
indicates the need for lamp rx The lamp status
should be checked as well se €ﬁ: '{b'nstrument > Lamp

Status/Replacement and <?€Nlﬂ%$ ndition,
5.3 In order to extend t Halogen Lamp, the
instrument should A& Eggﬁ anytime it 1is not in use.
00 hours.

Lamp life is app&g <§§
&b
QO
& o %
& VP
Q@
O
Qﬁ
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BI-316

STR AMPLIFICATION: PP1l6 HS

1.0 BACKGROUND:

DNA analyses have revolutionized forensic biology. The
advent of PCR allowed scientists to analyze evi tiary
material present in minute quantities and de ed states.
The identification of forensically significi‘ STR loci has
allowed scientists to combine the discripifdtion attainable
with the older RFLP technology with therspeed and sampling
capabilities of other PCR-based methoda ogies. The
PowerPlex™ 16 HS allows the co-amplj ion of the core

CODIS 13 loci, as well as, Amelﬁgeé@n, Q?. two

pentanucleotide-repeat loci, nta E.
Butler, J. Forensic DNA Typ lo nd Technology
Behind STR Markers. 2001Q c@m CER

PowerPlex™ 16 HS Systqﬁg?eégggéa anual
2.0 SCOPE: &
To provide a r\$} <$9t o for consistent, high quality

ampllflcatlon offender database samples ensuring

the generatlﬁh e PCR product for capillary
electroph sis and lyses of these STR loci.

3.0 EQUIPMENT/REAGENTS :

K\J
Thermocycler
Microcentrifuge

Microcentrifuge tubes and/or reservoir
96 well Reaction plate and base
Pipettes and tips

Foil Seal or Optical Adhesive Cover
Compression pad

PowerPlex™ 16 HS Kit Contents
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4.0 PROCEDURE:

4.1 DNA TEMPLATE:

4.1.1 Based upon the guantity of DNA isolated and its
initial concentration, the scientist should have all
samples at an optimal concentration for amplification
(e.g., 0.lng/ut). It is also convenient to have all
samples, that are to be amplified at the same time,at
the same concentration if possible for ease in the
preparation of PCR Master Mix and reactj agdditions.
The maximum amplification volume for\&é@ level or
undetected samples is 4.4p¢ for PowegPlex 16 HS,
quarter volume reactions. For la volume samples,
it may be necessary to concentnqtp the sample prior to
amplification. Qp

4.1.2 The amount of DNA templategﬁ,dedééb a guarter volume
amplification reaction s E geted at ~0.25ng.

4.2 AMPLIFICATION SET-UP:

4.2.1 Thaw the PowerPl r Mlx, PowerPilex 16 10X
Primer Pair Mi X» Tcation Grade Water
(optlonal) c e HotStart kit.

4.2.2 Calculat Qll“éggreactlon components needed

based of samples ({including extraction
and, Sgafl uw%@ntrols to be amplified and adding
to compensate for loss and
abl ggaé to pipetting. Use the ‘Amp.
rksheet’ b of the Database Worksheets Template
C§Q (Form 312-BI) tc automatically calculate necessary
"~ volumes. Print a copy of the completed worksheet for

<2 the batch record. The following is a list of the
'fixed' amounts to be added for a 6.25ul reaction.

PowerPlex HS 5X Master Mix 1.25u¢
PowerPlex 16 HS 10X Primer Pair Mix 0.6ut
'DNA Template + dH,0 4,430

lFor FTA extracted samples there is no volume for the
DNA template so 4.4u! of dH;O0 will be added to these
tubes.
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Note: The amount of Reaction Mix added toc each sample
is dependent on the volume needed tc add the DNA
template.

4.2.3 Prepare the reaction mix by pipetting the required
volumes of 5X master mix, 10X primer mix, and water
(if needed) into an appropriately sized
microcentrifuge tube or reservoir. Mix thoroughly and
pulse-spin if using a tube.

4.2.4 Pipet the appropriate amount of reactloxgbhx into each
well of a labeled 96-well reaction plafe. The
negative amplification coentrol shoulqsge the last
sample processed. qb

*

4.2.5 If DNA concentrations were not e gsame, add
appropriate volume of dHy0 aa§heq3§sary

4.2.6 Pipet each DNA sample in prlate well.
Use 9947A control DNA ﬂ@ﬁ t ive amplification
control and dHzO for\Qsé Qggatl amplification

control.
<2 \e} N
4.2.7 Thoroughly seak? h an adhesive foil seal.
Use a seal a@L @g t@tlghtly seal bhetween and over
each Well

\&0 &
4.2.8 Removebgéh touching only the plate,

tran es to the thermal cycler in the
Amp/ebs 22) , using the other hand on the door

k
'Sk
Place a compression pad over the plate and put it into

4.2
<2K the thermal cycler. Remove/discard gloves before
exiting the Amp/PostAmp room.

4.3 THERMAL CYCLING PARAMETERS:

4.3.1 After the samples have been placed in the thermal
cycler, turn on the power and select the appropriate
pre-programmed cycling profile,

4.3.1.1 For DNA IQ-extracted and low level FTA-
extracted samples, use 'ppl6HS' with the
following conditions:
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4.3.1.2

\.
2
o

<2K

Database Analytical Methods:

Page 39 of 67

96°C for 2 minutes,
100%
for
29%
for

te:
30 seconds,
to:
30 seconds

ramp
94°C
ramp
60°C
ramp 23% to:

70°C for 45 seconds
for 10 cycles, then:

100%
for
29%
for
23%
for

Lo:

30 seconds
to:
30
to:
45

ramp
e0°C
ramp
60°C
ramp
70°C

seconds

seconds

for 20 ecycles, then Q§>

\

60°C for 30 min g?
u*‘(e

\

\\C)

4°C soak

For FTA rgggga {i&?les
templap&?5< 16

S

then:

égb

<</

{other than low

with the following

Y @ used:
%QQ f\@o2 ‘Ngz{tes, then:

@Qﬁ&?ﬁ seconds,

to:
30 seconds
to:
45 seconds

ra

60°® for
ramp 23%
70°C for
for 10 cycles,

100%
for
29%
for

to:

30 seconds
to:

30 seconds
to:

45 seconds
then

ramp
90°C
ramp
60°C
ramp 23%
70°C for
for 17 cycles,

60°C for 30 minutes,

4°C soak

BI-316

then:

then:
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5.0 AMPLIFIED DNA PRCDUCT:

5.1 After cycling has concluded remove samples from thermal
cycler. Samples should be run on the Genetic Analyzer as
soon as possible after amplification. Prior to capillary
electrophoresis and/or before analysis is completed the

samples may be stored at 4°C. For longer storage periods,
samples should be frozen at -20°C. Amplified product is ONLY
stored in the Amp/PostBAmp room. <§D

5.2 At a point in time after STR analysis is co@§zeted (i.e.,
data has been reviewed and approved for ad), the
amplified product will be disposed of i biohazard
container in the amp/post-amp room, needed, this
container will be sealed and transp‘Q%ed directly to the
dishwashing room. The contalner laced into a second
biohazard bag, sealed and dlspo other biochazardous
material. ﬁéi

&
6.0 COMMENTS: QO 0@

6.1 Clean surfaces with h ?5; bleach solution or
PDispatch® prior to p@ 0

6.2 Wear gloves at \(LQ t@@sé{lng amplification set-up.

6.3 Mix all re s @ﬁ%r \ﬁiy {e.g., vortex) and pulse-spin
them in mi@toﬁ@#@“&z} r to dlspen51ng.

S

6.4 If ex sive evapg?ation is observed following
amp ication, an optical adhesive cover may be used to seal
Q?& late rather than the foil seal.

6.5 When using a Y volume reaction, the amplification reagents
may be completely absorbed by the 2mm BSD punch, if used for
the FTA extraction method. If this happens, 1t is
recommended that 5ul sterile water be added post-
amplification, and thoroughly mixed prior to running on the
genetic analyzer,
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BI-318

STR TYPING: CAPILLARY ELECTROPHORESIS AND DATA ANALYSIS

1.0 BACKGROUND:

Any eukaryotic genome is interspersed with repeated ®NA sequences
that are typically classified by the length of thqb ore repeat
sequence, and the range of contiguous repeats t cally seen or
the overall length of the repeat region. Q§§irt Tandem
Repeat) locl are scattered throughout the g e occurring every
10,000 nucleotides or so, and have core r%%éét units of 2-6bp in
length with overall lengths of less tha&§§

STR loci examined for human identif r(§%1 oses were selected
for the following characteristics Qﬂ R;ﬂ rlmlnatlng power
{generally >0.9}) with observed S~ rﬁgag§§§b of >70%, 2) loci on
separate chromosomes to avol %SE Q§> 1lity to obtain
robust, quality, reproduci%&i uitiplex amplification is

performed, 4) low stutterﬁb qgion rate and 6} small
allele sizes (<500 bp) \\ ceﬁ:ht of analysis of degraded

samples. AN

X L L <&
By 1997, as the re unlty -wide forensic science
effort, the foll ng €$§> QYBCL, all tetranucleotide repeats,
were selected ag) or NDIS, the CODIS (COmbined DNA Index
System) Nati 1 Databgé?) D351358, THol, D21s11, D18S51, D58818,
D13S317, D7E®20, D16S5 CSF1PO, vWA, D8S1179, TPOX, FGA. When
all 13 C core loci were examined, the average random match

probabszg vy was found to be <1 in 1x10*? among unrelated
individuals, offering the promise of individualization.

In addition to the 13 core CODIS loci, the PowerPlex 16 HS
multiplex includes Amelogenin, a gender identification locus, and
two pentanucleotide repeat STR loci, Penta D and Penta E. STR
typing, with amplified products generated from this kit, separated
by capillary electrophoresis on the 3130 Genetic Analyzer with
data collection and analysis software employed in developing the
genetic profiles, will be used to produce STR profiles from
convicted offender samples for entry into CODIS.
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Butler, J. Forensic DNA Typing: Biology and Technology Behind
STR Markers, (2001} Academic Press.

PowerPlex™ 16 HS System Technical Manual
PowerPlex® Matrix Standards, 3100/3130, Technical Bulletin
ABI 3130/3130x1 Genetic Analyzer Getting Started Guide

ABI 3130/3130x1 Genetic Analyzer Mainenance Troubleshooting

and Reference Guide ng
. o
GeneMapper™ ID Software User Guide ~§
@
2.0 SCOPE: CED
'\
To provide a reliable method for geneﬁ§%§n STR genetic
profiles from offender DNA database ksg
< O
3.0 EQUIPMENT/REAGENTS : @ é

3130 Genetic Analyzer wit22 Q§1\§§§ion Software

GeneMapper™ ID Software
Computers \@ \Q O
9700 Thermal Cycler ~x0° O Q
Pipettes and Tips (O <

N\
Benchtop Cooler O ()\ &Q/
Capillary Arra
96 Well Reac <g§> Septa
Buffer Resexy 1r®(énd @pta
POP4 Pol QO
Genetlcqén yzer B&E}er

PowerP 16 Kit HS Contents
Po (ﬁlex@ 16 Matrix Standards
Degznized Formamide

Nanopure Water

4.0 PROCEDURE:
4.1 AMPLIFIED FRAGMENT DETECTION USING THE 3130

Note: Prior to using the ABI 3130 Genetic Analyzer for
samples, a spectral calibration (matrix standards} must be
run to achieve proper color separation of the dyes used for
the amplification primers, allelic ladders and size
standard. To prepare a matrix, four standards are run
under the same capillary electrophoresis conditions that
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will be used for samples and allelic ladders., Use the 3130
Matrix Standard set, which includes the Fluorescein Matrix,
JOE Matrix, TMR Matrix and CXR Matrix for the blue, green,
vellow and red matrix standards, respectively. This is
performed when necessary due to performance, or after any
instrument maintenance/repair that involves
adjustment/replacement of the CCD camera or laser.

Additionally, a Spatial Calibration must be performed prior
to running any samples. The instrument uses images
collected during the spatial calibration to eségélish a
relationship between the signal emitted for e capillary,
as well as the position where that signal f 5 and 1is
detected by the CCD camera. This is pengfﬁed any time a
capillary is installed or replaced (inc ng temporary
removal of a capillary) or if the insq%§ﬁent is moved.

4.1.1 Turn on the computer, t ‘S;xjﬂe instrument,

start Data Collection d walt for green

squares to appear fo jons on the
service console. an Qy essary subfolders

on the left tre Collectlcn Refer
to the ABI 3130 ic Analyzers Getting
Started Gui &_ &ta@g instructions on
instrumen K(} ding creation of
instrument k%( results groups, and spatial
calibr —1n appropriate information in
the %5 mgé Log (Form 422B=QC).

&h §2performed in the opposite order
~§Eata\:%ké§bklon software, 3130, then computer).
€§T e Data llection Software must be closed by
(Q checosing ‘Stop All’ and wailting for all red
<$> symbols to appear before closing. Never use the
<2 ‘X' to close while green or yellow symbols are
displayed.

4.1.2 Create a new plate record:

4.1.2.1 For a spectral calibration plate expand
the tree pane of the Data Collection
Software and click ‘Plate Manager,’ under
‘ga3l130x1l’. Choose ‘New’, and fill in
the dialcg boxes, with ‘Spectral
Calibration’ as the application. Fill in
the applicable dialog boxes on the
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Spectral Calibration Editcr as follows
{clicking ‘OK’ when complete to save):

Sample Name: date Spectral

Priority: May optionally be changed to a
number <100 for injection priority.

Instrument Protocol 1l: Choose_the
Spectral instrument protocol m the

-

drop down menu \SSD

PowerPlex 16 specific x%ﬁbmodule and
protocol settings foreSpectral
Calibrations are asng lows:

Module Type: {5% Spectral
Template: C)O &Spect36 POP4
Inj. kV:

Data Del\QS) @ <(/ 100
Run ’I‘Q (s&)‘& n@ 800
Pr ’&c \S%QO Spectral
%5?25 E
6{5(\00}@.9@@ I?/Jgtrix Standard

e ndition bound: 4.0
P condltlon bound: 12.0
S \50 2
@ &j.Secs 5

C§2 4.1.2.2 For a sample plate finish filling out the

<2§, 3130 Load Sheet on the database worksheets
template (Form:312-BI}. Print a copy for
the CODIS file. Choose the ‘3130 Plate
Document’ tab and ensure the information
corresponds to the Load Sheet information.
Verify the information on the template is
as follows:

Container Type: 96-Well

Application Type: regular
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QQ’&
O
<2§

Database Rnalytical Methods:

Page 4% of &7

\5(\

GeneMappexr: GeneMapper Generic Instance

Sample Name:

Allelic Ladder: LADDER (or PP16 LADDER)

Controls:

Y

POS [or
etc.],

{(+3,
RB

etc.], NEG {or (-
(reagent blank)

Database samples: LDEF#SH####44
(e.g., ID2001001412).Q§9
.\Sb
Priority: May optionally{§§ changed to a
number <100 for injectj priority.

Sample Type: Sampl ‘égtegorles of

‘Sample’ ‘Alleli <bad erf, ‘Positive
Contrel’, or N ontrol’, may

optionally be
Results G:s@&;b 1: Q\?\§%? the appropriate

results p.{MTh are typically

deﬂote st initials and
shou
L%&

ly populate from the

st@k@leﬁ'& rotocel 1: Enter the
i%¥e instrument protocol (e.g.,
€§§éc, PP16 3 sec, PPL6_10 sec).

rPlex 16 specific run module and
tocol settings for sample plates are

as follows:

Module Type: Regular
Template: HiDFragmentAnalysis3é POP4
Inj. kV: 3

Run Time (seconds) :2000

Protocol Type: Regular
DyeSet: F
Inj.Secs: 3-10

3 secs - Generally produces good
results for Allelic Ladders and
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Q‘OQ

samples 2.25ng (injection times
may be adjusted {3-10 seconds
per analyst's discretion}.

5 secs.- Samples <.25ng generally
produce good results.

4.1.2.3 Delete any unused wells. Perform a ‘Save
As’ of the Plate Template Worksheet to
disc {i.e. USB drive) for subsequent
transfer te the ABI 3130. The document
must be saved as a .txt file

delimited). \SSD

4.1.2.4 Import the previously s$g§ﬁ plate record by
selecting ‘Import’ on ‘Plate Managerx’
window. Browse to 1 te the saved .txt
file and choose ‘Q§$>

4.1.2.5 Open the impor gpaii?e cord by
hlghllghtln Qat a 1ng ‘Edit! .
Review th fq&@b n the GeneMapper
that it is correct

Plate Egd@dr
or ma {2, ecessary. Click ‘OK’
when @npé t@ ave the plate record.

4.1.2. 6 o Q? re than one run of a sample
g} ple injection times), select
e> ample Run in the GeneMapper

ltor window. This will add
onal Results Group and Instrument

{SA ocol columns to the end of the plate

ord. These additional runs may be
added at any point in the run, prior to
the last injection, if the scientist
notices that a sample would benefit from

re-injection (e.g., repeat because of bad
injection or to vary injection times
[from 3-10 seconds]). Additional Results

Groups and Instrument Protocols may also
be filled in on the original Load Sheet
template prior to importing.

4.1.3 In the manual control window, the scientist may

choose to set the oven to 60°C so that it will be
ready to run. Choose Oven in the ‘Send Defined
Command for’ drop down menu box. In the ‘Command
Name’ box, choose Turn On/Off oven, with a
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‘Value’ of On, and click ‘Send Command’. Next,
in the ‘Command Name’ box, choose Set oven
temperature, with a ‘Value’ of 60.0 and click
‘Send command’ . Note: once the oven has been
turned on and the temperature set, the oven will
only preheat for 45 minutes before shutting
itself off.

4.1.4 Prepare samples for capillary electrophoresis:

4.1.4.1 For amplified products 1nclu€$m
controls}), typically 1lpé-1 rxn 1is
added to 10u¢ of ILS Mast ix (made by
adding 0.5u¢ ILS600 s1% Xandard/sample,
9.5u¢ deionized formamide/sample and
adding guantities f +2 in Master) that

has been dispense8§§nt; the wells of a

pre-labeled plaﬁi‘ Allelic Ladders

add 1lut¢ Ladde ster Mix. Note:
The master ' ered by adding
0.25u¢ IL S;e g§39.75p8 deionized
formaml@h s are too high.
4.1.4.2 Matrx@s dlluted 1:10 in
%§§2> pe of each matrix dye
hen added to 480pt¢ of
éééf rmamide (without size
Load 25 ut of the fragment

fb s :
\6 g(each of four wells on the pre-
@

\)(‘1 4 plate, which will include each of
four capillaries {e.g. wells Al
QSS g:kough D1).

«éai 5 Following sample addition, place a plate septa on

<2 the plate and heat denature for ~3 minutes at
95°C., Immediately chill in benchtop cooler (or
on ice) for 23 minutes {perform on all sample
types — ladders, matrix, controls and samples).
Note: the plate septa may be cut to cover only
those well columns being used on smaller plate
runs.

4.1.6 Place the sample plate into the plate base and
secure the plate retainer clip on top, making
sure that no gray 1s visible through the holes,
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4.1.,7 Place the plate assembly in the instrument and
close the doors. The plate map on the ‘Plate
View’ window, under ‘Run Scheduler’ will turn
yellow when the plate is in place and has been
detected by the instrument,

4,1.8 Prior to running the plate, confirm that dye set
F is selected and the correct active calibration
for dye set F is set in spectral viewer,

4.1.9 Locate the plate record in the ‘Plate @iecw’
window and highlight it by ciicking»@g?it once.
With the plate record hlghllghted \1ick the
plate map to link the plate to specific
record. The plate map will t from yellow to

green when it is successf:§é§> inked. Verify the

correct scheduling of the n the ‘Run View’
Ei%m that the
n the plate

window, Select a run a

corresponding wells hi ﬁ}

diagram are correct Make
adjustments to thanlateé$§§§§§ i1f necessary.

4.1.10 Click the green<%un.i§% nt arrow button in
the toolbar un. Monitor
electroph v1ng the run, view,
array, viewer window. Each
1n]ect r samples) will take ~45
minu o run a duplicate plate record,

qéaay d to be unlinked prior to
plicated record. This is done by

1gh11 Kﬁ?}'the currently linked plate record
{\a g

d clic ‘unlink’.

G§%1 After completion of the spectral calibration run,

<2K open the ‘Spectral Viewer’ window to evaluate the
spectral and set the active calibration. Confirm
that Dye Set F is selected. Click on individual
wells in the plate diagram to see results for
cach of the four capillaries. For each
capillary, verify that four peaks are present in
the spectral profile (upper pane), that the order
of the peaks are, from left to right, blue-green-
yellow~red, and that the peaks are regular in
appearance. Next verify that four peaks are
present in the raw data profile (lower panej,
that the order of the peaks are, from left to
right, red-yellow-green-blue, and that the peak
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heights are above 750RFU (1,000-4,000 RFKU is

ideal). 1If all four capillaries pass, then the
calibration should be saved and set as the active
calibration.

Note: All four capillaries must pass in order to
accept a spectral calibration. A passing
capillary will be colored green in the plate
diagram. Additionally, capillary status may be
viewed in the ‘Event Log’ under ‘Instrument
Status’. Rerun the spectral calibratd Gh as
necessary until all four Caplilarleggggss

4.1.12 After completion of the run fi <B filling out

the 3130 Injection Log (Form | 22B=0C) .
'\

4.2 DATA ANALYSIS: GENEMAPPER® IDcygf Q*

4.2.1 Data analysis is NOT ‘%é the instrument
computers, Trans ééb der (including
the 3130 piate analysxs computer
using a portabl After analysis and
review are c y of the run folder and
GMID proj stored on an analysis
computer_u 11 D archiving has been
comple <§gn Folder on the instrument
comg@?é é§§} Qyi leted at this point. Case-

ic @} be made for discovery upon
\. ote: £;} to data analysis, the appropriate

(é panels and bins must be imported into GeneMapper®
{SD iD. Additionally, previously run Macintosh data
<2 must first be converted to PC files using the
‘Mac to Win’ conversion program.

4,2.2 Set up the analysis methods for GMID analysis as
follows (analysis methods are created and stored
in the ‘Analysis Methods’ tab in ‘GeneMapper
Manager’):

‘General’Tab: Name the analysis method so that it
reflects what the methed is (e.g. 3130PPl6-
150R¥FU) .
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‘Allele’ Tab: Choose the appropriate bin set.
Choose ‘Use marker-specific stutter ratioc if
available’, and ensure ‘minus stutter distances’
are from 3.25 to 4.75 for tetra and from 4.25 to
5.75 for penta. All others should be 0.

‘Peak Detector’ Tab: Advanced Peak Detection
Algorithm, partial sizing (80-550 or 600), light
smoothing, Local Southern size calling method
with baseline window of 51 pts, min. peak half
width = 2, polynomial degree = 3, peaé?ﬁindow
size = 15, and slope thresholds = 0.,()

K\
Analysis range may be set to e' K&t full or
partial and is empirically de ined for each
run and/or instrument. Wh 1ng partial range,
the start and stop points etermined by a
review of the raw data h€§§lng points that
will not include the g% but will cover
the size range of 80

Peak Amplitude é%shoé@é depend on sample
quality. Gener 1y ﬁgﬁj threshold in all
colors., Rfu }\ be raised in Blue,
Green and %bo elic Ladders if

necessar
riu at
Thre
in

fﬁb h sNold may be lowered to 100
y discretion (see 4.3.2 RFU
42? below 100 rfu are deemed

(\
*Peak\a.l&(’ Tab: The minimum peak height ratio
Q§§Tor Hete ygote Balance should be set at 0.5 for
database {(CODIS) samples. Set the max peak width
Q to 1.5 bp and pull-up ratio to 0.05. The signal
<2 level and allele number may be set according to
analyst preference and sample type.

d)

‘Quality Flags’ Tab: The gquality flags are only
used as a tool to aid in data analysis and review
(i.e. to assist in calling attention to potential
artifacts or data guality concerns). These flag
settings may be adjusted according te analyst
preference and sample quality.

4.2.3 Create and store a size standard for GMID
analysis, under the ‘Size Standards’ tab in
‘GeneMapper Manager’. Name the size standard so
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that it reflects what the standard is (e.g.
IL.S600 80D-600).

Data analysis will be performed using the ‘Basic
or Advanced’ size standard. The size standard
consists of the following peaks: 60, 80, 100,
120, 146, 1eéC, 180, 200, 225, 250, 275, 300, 325,
350, 375, 400, 425, 450, 475, 500, 550, and 600
(the 60 and 600 peaks may be optionally defined
by the analyst).

®6

4,2.4 Create a GeneMapper® ID Project: gS)

4.2.4.1 From the GMID main men Qgélect File/Add
Samples to project. Highlight the
appropriate run fol in the pop-up
window and cllck o List’. Once the
run folder has é§é§ed to the column
on the rlght to populate the

project w1thqghe 1n the run
folder. ’ @

4.2.4.2 Tn the g& for each sample,
sele t e type, analysis method,
%25565 standard from the pull-
dders must be assigned the
m §Q ‘Allelic Ladder’ for the

e§} q;i} o occur. In order to use the
\\ concordance quality flag, all

éép s must be marked appropriately as

{éa ‘Positive Control’, or ‘Negative

Qé\ trol’. All others may be marked as
(Q ‘Sample!’
©
<2 4.2,4.3 Save the project as the date MMDDYY,

followed by CODIS (and any other
descriptors that may be necessary).
Note: the analyzed project will be
exported to the run folder at the
completion of analysis/review.

4.2.4.4 Analyze the samples by clicking the green
Analyze button. If the project has not
already been saved, a prompt will appear
to enter a project name before analysis
will commence.
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4.2.5 Evaluate GeneMapper® ID Data:

4.2.5.1 The Raw Data may be reviewed to determine
analysis start/stop points, or to
identify baseline problems, off-scale
data, excessive 'spikes' or other
anomalies that may interfere with data
analysis and require re-injection or
other corrective measures. Expand the
run folder located in the navigation pane
on the left. Highlight the safiple(s) of
interest to view the associ sample
information, raw data and data.
Minimize or highlight ¢ xrun folder to
return to the main projett window.

4.2.5.2 Check the ‘SQ’ (si(ﬁ?\g quality) for all
samples. A gree Q% indicates that

the sample haQ% éifb bgésizing criteria
and need no ma 1{%} xamined.
Examine t Qggﬁ qé>ﬁ;§gg d of each sample
with vye a r ‘SQ" to confirm
correcfégézbqgme f fragment sizes.
ngh},@ éﬂ e{s} of interest and
gth@l tch Editor button. If
n 2;%st the peak assignments by
ng Ch g on a peak and deleting,
6(0 ad %}d/or changing values. If all

correctly labeled but the
Zé;? score is below 1.0 (may be
~§ d by choosing Tools/Check Sizing
{S' 1ty click the ‘Override SQ’ button
<Q to set the SQ to 1.0. Once all edits
<$) have been made, click ‘0¥’ to save the
<2 changes and close the Size Match Editor
(clicking ‘Apply’ saves the changes but
leaves the Size Match Editor open).

These samples are ready for reanalysis in
the proiect window.

Note: Data may still be deemed acceptable
without the ILS 60 and/cr 600 bp peaks
present. If additional peaks are
assigned because of bleed-through of TMR
peaks (typically Amelogenin peaks), the
scientist may choose an Analysis Method,
with an increased rfu threshoid for the
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red channel to prevent these peaks from
being detected, 1f desired.

4.2,5.3 Examine the blue, green, and yellow
allelic ladders. Check that correct
allelic assignments were made.

Note: GMID automatically averages all
valid ladders in a run for genotyping.
Genotypes are assigned by comparing the
sizings of unknown alleles f%g? samples
with the sizings of known ald@les
contained within the aver d allelic
ladders of each locus. -~ &)ladder(s) may
be omitted from analysie by deleting it
from the main proje%g\ indow prior to

analysis. <\

4.2.5.4 Data may be e <%. rious
comblnatlo /or tables to
1dent1f splkes, stutter,
-A, oif= s, etc. Sample
Plots v ewe ‘Samples’
tab/wébdowé}ﬂA all loci in a given
co QE% iewed simultaneously.

s view from the

QE}p <€fab/w1ndow, however, allows

viewed individually {(more than

’b
e> a§§ can be viewed at the same time
QQQY% stlng the number of panes

{SS d) .

<Q 4.2.5.5 GeneMapper® ID includes a series of
{S) quality flags (PQVs) to alert the analyst
<2 of potential sample guality concerns. A

green square indicates that sample data
has passed all of the quality checks, but
yvellow or red indicate that the data has
a problem with one or more of the quality
checks. A vyellow or red flag does not
necessarily mean that the data is bad or
unusakle and the flags are not to be
relied on solely. The analyst may choose
to use the PQVs, in combination with
manual data examination to aid in the
identification of bleed-through, spikes,
stutter, off-ladder variants, -A, etc.
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Q‘OQ

Once the data has been evaluated and
deemed acceptable, the analyst may choose
to override the yellow or red Genotype
Quality (GQ) flag by right clicking on
the flag in the Genotypes Sample Plots
view. Note: overriding the G flag will
cause all other flags to turn from the
original color to gray.

4.2.5.6 All negative controls {including reagent
blanks) should be examined to Gerify that
each displays a reiatively.ﬁ% t baseline
in blue, green and yellow<é

4.2.5,7 Review all samples (1né&hdlng positive

controls) for the a listed
‘artifacts’ and ev ate: peak height and
shape, matrix nd individual

sample profll é;&a&) each sample
Tadd

with the all and examine
for off-1 ariants, signals
that we qgﬁoo bﬁ%&be genotyped and
assignm pes to stutter peaks
{or méﬁor at may have been

S

QQtutter' etc.
4.2.5, €<\ an Q'\z %l‘fldual samples with
Q> Analysis Methods, as necessary

\6 é‘@ u cut-off will need to be

{54 2.5.9 ﬁalt peaks as necessary, by right
clicking on the peak label and selecting
‘add allele’, ‘delete allele’ or ‘rename
allele’. The allele should be labeled,
at minimum with the allele call, however
the analyst may select up te four allele
labels, including peak height and size,
from the ‘Plot Settings Editor’ window.
Note: labels added to artifact peaks,
such as spike, pull-up, etc. will appear
in the Genotypes table as an additional
allele.

4.2.5.10 Samples demonstrating an off-ladder (<
or > smallest or largest ladder allele,
respectively), tri-allele, or
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microvariant (alleles with incomplete
repeats) allele({s) should be re~analyzed
for verification. Microvariants will be
labeled and reported as "X.Y" (where X is
the number of complete repeats and Y is
the number of basepairs of the incomplete
repeat). Off-ladder will be reported as
> or < the largest or smallest ladder
allele, respectively. HNote: the
nomenclature for upload to NDIS may
necessitate a change in allel

designation.
O
4.2.5.11 GMID automatically fz%gfébff scale
(camera saturatiocn) This data may
still be acceptable,. it is limited to a
few or a single p and the coverall data

for that sample«& fQ ood gquality (see

4.4.7.4). <Z (:§>
4.2.5.12 Export aq\gfgelé}g ‘izes table to

Excel \&} the run folder. The

table kk p ed for the CODIS file.

The k@%le\éﬁ Qggi%lso be exported as a
ﬁ}fl DIS import. To create a

' Q{Q specimen category must be

AR y§a the export fields set in the
Q} Cgb' ort Manager’ under toocls in the

ile, Only one of the allelic ladders
need be printed for documentation

‘\
@@9 Q t the ‘Samples Plots’ for the CODIS
{$§Q purposes.

%

4.3 STR INTERPRETATION GUIDELINES
4,3.1 CONTROLS

4.3.1.1 The purpose of a REAGENT BLANK (RB) is
to determine if the reagents used for
DNA extraction/isolation were
centaminated with human DNA and as a
method for monitoring facility
decontamination. In GeneMapper®, ID
peaks above threshold should only
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Database Analytical Methods:

Page 56 of 67

appear in the CXR (red dye) lane,
corresponding to the ILS5600 size
standard. Electropherograms for the
blue, green and yellow dyes should show
a relatively flat baseline throughout
the range (discounting primer signal,
fluorescent 'spikes' or CXR bleed-
through). If detectable signal, with
characteristic 'peak' shape is visible
in the electropherogram of a reagent
blank and does not disappearCmpon re-

. injection, results for al sociated

samples may be deemed lQéghclu81ve
(close examination at-80'rfu is

performed on all sa s to examine for
presence of any a es seen in the
RB). Data may b eemed acceptable if
contamination 'gb ated' to the RB.

The reagent? bc d be treated the

same as th Q?g trated DNA
sample e er f<%;1mm and amount
éﬁ i time/amount, and

ampli
analygzs UQ' s Additionally, the
¥11 be reamplified with
é}le ‘9
q%% s conditions are more

e set 1f any of the
han the original,

'%D pose of the POSITIVE

FICATION CONTROL (9947A DNA
&pplied with the PP16 HS kit) is to

C)ssess the amplification process,

ensuring that adequate sample amplified
simultaneously would produce an
appropriate signal. All expected
alleles (see helow) must be detected,
using standard parameters or all of the
samples associated with amplification
may be deemed inconclusive. Data may
be deemed acceptable 1if all alleles are
present (though some are below 150-rfu
threshold) AND the other positive
control {Extraction Control) appears as
expected {i.e. the problem is confined
to the 9947A sample).

Revision 9

BI-318

8/10/09

Issuing Authority: Quality Manager




LOCUS GENOTYPE LOCUS GENOTYPE

D351358 14,15 THO1 8,9.3
D21811 30,30 D18S51 15,19
Penta B 12,13 D55818 11,11
D135317 11,11 D75820 10,11
D165539 11,12 CSF1PO 10,12
Penta D 12,12 AMELOGENIN X, X
vWA 17,18 D8s1179 13,13
TPOX 8,8 FGA 23,24
@6
O
R\
\
4.3.1.3 The purpose of the Né%ATIVE
AMPLIFICATION CON is to determine
if any human DNA ntamination occurred
in the process{gﬁ ification set-up

{(or beyond qg&h Eigy
method of

deconta ﬁ?ﬁl

elect ghe eaks above

thres 1d ngu nly appear in the CXR
a

(reé;dyexsﬁ, corresponding to the
%@OO @z&andard .
grams for the blue, green

dyes shcould show a
ly flat baseline throughout the

Q§> () an dlscountlng primer signal,
() \:> escent 'spikes' or CXR bleed-
{éﬁough) If detectable signal, with
{S' haracteristic 'peak' shape, is visible
(fb in the electropherogram of a negative
{S) amplification control and does not
<2 disappear upon re-iniection, results
for all of the samples associated with
that amplification will be examined for
the presence of the same peak(s}.

)ﬁnd as another
ility
e GeneMapper® ID

If extraneous peaks appear only in this
control, the data for other samples
assoclated with that amplification need
not be deemed inconclusive. This
occurrence should be documented and the
scientist's determination (and basis
for it) documented in the case file.
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4.3.1.4 The purpose of an EXTRACTION CONTROL
sample is primarily to assess correct
genotyping, however, it does take
measure of all of the steps in the
analytical process from extraction
through allele designation. The
extraction controls consist of
previously typed buccal samples on FTA
cards prepared in batches. An
extraction control must be run on every
sample plate., The reviewing Grientist
will complete an Extracti ontrol
Check Form (Form 212-BI}\For verifying
correct genotype(s). . &'copy of this
form will be include n each CODIS
Data file. TFailurelsf the extraction
control, if 1sol d to that sample,
will not deem Qher ﬁ%mples
1nconclu51vg2(> <:§§Q

e S

4.3.2 RFU THRESHOLD: \\Q {</

{}
4.3.2.1 For c§bzs ‘$ N:X database samples, a

ml&@ﬁﬂnx@§ fu should be achieved
:&@} tance. If necessary, go
k\t 224 rocess as follows: repeat
Qi .M$3 changing injection time; 3-
é§> s allowable range}, or perform
\§> CED ysis {i.e., changing amount of
é} QS aﬁé;?fled product added for fragment
\:> alysis), or re-amplification

{SS C)ujmuease DNA template), or re-
(ﬁb extraction.
KO

4.3.2.2 Peaks below the analysis threshold
(hbased on data obtained and
signal/baseline} will not be
interpreted but should be noted as
being present in the notes {eg. on the
table of results).

%

4.3.2.3 Peaks marked as off-scale in GeneMapper®
ID (indicating camera saturation) will
not be interpreted if multiple peaks
are affected and if it causes excessive
artifacts (e.g. split peaks, increased
stutter, pull-up, etc.) which interfere
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with data interpretation (see
4.2.5,11). If the overall quality of
the data is not acceptable, the sample
must be diluted, re-injected (3-10
seconds), reanalyzed (decrease the
amount of amplified product added) or
re—amplified (decrease DNA template) as
deemed appropriate by the scientist.

4.3.2.4 Multiplex amplification kits are
designed so that heterozygoué) loci in

single-source samples gen 1y
demonstrate relatively nced peak
heights [typically 270%peak height
ratio (phr)]. Some ples, although
single-source, may- times demonstrate
greaterxr 1mbalanc&§gue to degradation,
stochastic eff g@s, imer binding site
mutations, a(\ampllflcatlon,
etc. Pea g{t for these loci
(<50% samples will be

flaggs?

4.3.3 EXTRA PEAK%@NON\@}L

4.3.3.1 C@R \@l %tlon of STR loci typically
\QOp c&@c & minor product peak one core
é¥> e Szﬁmit shorter than the main
Ghl. peak (n-4 for tetranucleotide
\:§> ld%} and n-5%5 for pentanucleotide loci}.
s minor peak is referred to as the
tutter peak. Percent stutter
(Q generally increases with allele length
{S) and does not change significantly with
<2 the guantity of input DNA (peak heights
within ~150~-4500 RFU). The measurement
of percent stutter may be unnaturally
high for main peaks that are off-scale
or due to problems with matrix
performance and can be corrected by
diluting {or reamplifying less DNA) the
sample and/or applying a new matrix.
Locli stutter values are listed in
Appendix A of the Biology Quality
Manual to assess potential contribution
to peaks in stutter positions. N+4
stutter may also be seen on occasion.

@
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4.3.3.2 Electronic or fluorescent spikes are
random events that produce generally
spike-shaped peaks in most or all dye
colors at the same location {(equivalent
bp size} within a single injection.
Peak heights usually vary between dye
colors for a given spike. These
anomalies are generally not
reproducible and will typically be
eliminated upon reinjection.& If the
spike is above the analysigthreshold
and falls within an all 4&% range that
could interfere with §§her computer
analysis or scientist analysis, the
scientist will labeMthe spike in the
GeneMapper® ID s are so that it
appears on the

electropherq%gameggs

&
4.3.3.3 Dye “bl Qggbaqé}an ‘§Ees that
typiczéé}»océﬁr ' e same approximate
locati®n EQ' ulkbiple injections and do
non?&way$>d' ear upon reinjection.

%@’e@ne look like broad or
T a

ks and may occur in a
C)sng)e AQ r or multiple colors at the
\(\ séhe a%yroximate location but can vary
Qri predght. The blob should be labeled
é} \:§> o e glegtraphgrogram'(in GﬁID) if %t
\§ s within a diagnostic region and is
{5' C}f significant size to potentially
C§§b interfere with analysis.
<

<2 4.3.,3.4 Bleed-through or pull-up peaks are a
result of the matrix not correcting for
all of the spectral overlap (most
common with the PowerPlex 16 HS kit
from yellow into red) and may be
increased due to off-scale peaks.
These pull-up peaks are in the sane
location (same bp size) as peaks in
another color(s) and are easily
recognized. The presence of bleed-
through should be labeled on the
corresponding electropherogram (in
GMID) if it falls within a diagnostic
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region and is of significant size to
potentially interfere with analysis.

If excessive pbleed-through occurs in a
color other than red, and is not due to
off-scale data, a new matrix may be
used at the analyst’s discretion to
correct for the problem.

4.3.3.5 Tag Polymerase can catalyze the

addition of a single nucleotide
(predominantly adenosine) Cthe 3’
ends of double stranded PC@?%roduct

. resulting in product on ge pair
longer than the actu e<érget seguence
(+A). Amplification rameters include
a final extension e, so that the
reaction is driv to full A addition
(i.e. all prodqgﬁ qii% . Split-peaks

may ogccur aQ2£> f incomplete A

addition a ap a;r }Qé single allele
represe #\ §w § one base pair
apartéék‘ %§F $ his can occur when

the ampunt ate DNA is too great
oadgh le). In this instance,
&;} 15 o add the A nucleotide

Q%i amount of product

\CS)geQ§3 éQ n the time allotted. These
o) egzﬂdll typically contain off-

\6 O akeNdata as well. Split peaks can be
é} \:§> a iated by incubating samples at 60°C

\§ an additional 45 minutes, followed

{5' C}y dilution prior to reinjection. It
(55 may be necessary to re—-amplify the

<$) sample with less template DNA,

%

4.3.4 MIXTURES

4,.3.4.1 1f, after the elimination of possible
stutter and/or bleed-through, a profile
shows at least 3 peaks at 2 or more
loci, this is strong evidence of a
mixture.

4.3.4.2 Loci that demonstrate only two alleles
but have a heterozygous ratio of <50%
may also be indicative of a mixture.
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N\
3.0 Comments: QD

5.1

However, if data are obtained from
multiple loci, a scientist should
expect to see this or other mixture
indications {> 2 alleles) at additional
loci,

4.3.4.3 Sanmples showing evidence of a mixture
are to be deemed inconclusive, as
offender database samples should be
from a single source. An effort should
be made to determine the sou®ye of the
contamination, if p0551bl d to
determine if other sampkﬁs may be

affected. c2$§
O

The 310 POP4 Pclymer and tQ%fSiaf$§% Polymer are
different and are not to 1n§§§ hangeably.
The 3130 Data Collec oes not ailow the

entry of spaces or d he Qh es, sample names,

etc. An underscoméﬁmnﬁSbe d in place of spaces
when entering %2)

Low level c G)ml <§few peaks below 50 RFU) may

be seen p th the Biomek 3000 extraction.

The con be disregarded if it is isolated

to onl on the plate, all peaks are below
xbandfk

Q& eous peaks do not interfere with
callln n the samples.

QO
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BI-400

DRIFTCON FFC: TEMPERATURE VERIFICATION

1.0 BACKGROUND:

Successful DNA amplification is dependent on consdstent
thermal cycling parameters and achieving propencg%ating and
cooling to facilitate the various steps nece S§ y for PCR.

It is necessary to employ a method of moni i1ng the thermal

cycler performance and verify that the co ct temperature
has been achieved in order to have cont nce in the
amplification process. A variety of erature probes have
been developed to test the temperat £ o pec1f1c wells
within the different thermal cycgzﬁ)lns nts. However,
most of these have proven to be b mgss ime consuming,
and not amenable to testing th ra@l>time PCR
instruments. The Driftcon a@} €§> test multiple
temperatures within a shorspe 'Qé ime and can be used on

the thermal cyclers, as*@ﬁ. ﬁsbr ime instruments.

Driftcon Operations M%}anSZS? <;2n 1.1

Driftcon Quick %@: @i @ers;on 1.4
2.0 SCOPE: 0(\ %

To prov1d§§a rellabﬂ:)method for verifying the performance of
lakora thermal cyclers, to include real-time PCR

inszéqﬁk ts.

3.0 EQUIPMENT/REAGENTS:

Computer with Driftcon Sofiware
Driftcon Hardware Module and Cables
Driftcen FFC Fixture

Driftcon Smart Card

ABI 7500 FFC Adaptor

Cork Leveler
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4.0 PROCEDURE:
4,1 9700 THERMAL CYCLER VERIFICATION

4.1.1 Set up the Driftcon by connecting the hardware
module to the computer and FFC fixture/probe plate
with the provided cables.

4.1.2 Insert the smart card into the Driftc hardware
module until it stops. xs;

Q)
4.1.3 Turn on the Driftcon computer. ,’;(?@%n the Driftcon
Software and login with the aQB riate user name
and password.

4.1.4 Turn on the 9700, place t@ f@ure into the plate
with the cable fac1ng ct/start the

‘Driftcon’ protocol the 9700 lid as
it will damage the 01d the warranty.

4.1.5 In the Dr1ftcon<26ftué§e,‘gboose the instrument to
be tested. IiSﬁhe\é}S instruments does not
appear aut é}y, ck start and follow the

wizard pro S\\

4.1.6 Choos Q?ﬁftéén default protocol and make sure
é@ps ﬁlt ose in the 9700 protocol. Leave
ressure, and temperature blank.
ter éséas needed (these will appear on the
(Y nal rep

JQS§Q7 Start the test by clicking the check mark in the
<2 lower right corner. Make sure the 9700 has heated
completely and the protocol started before
starting the test. The protocol will complete in

~25 min,

4.1.8 The analyst need not be present once the test has
started; however, additional views/information are
availabkle during the run by pressing the F& key
for a surface view (heat dispersment), F7 for
measurement values (shown in real time), and F8
for measurement locations (probe wells).
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4,1,9 Once the run has completed, print the report and
place it in the QC binder. Connect to the printer
as follows:

a. Right click ‘My Computer’

b. Choose ‘Manage’>‘Device Manager’

c. Select ‘Network Adaptors’

d. Double click ‘Intel(R) PRO/Wireless LAN 2100 3A
Mini PCI Adaptor’

e. Open the ‘Wireless Network’ tab

f

Fncryption to 64 bit from the dro n menu
g. Fnsure that the ssid is Linksys<§
h. Click ‘0K’ and close all winde®@h

. Click the ‘Security’ button and chag@y the Data

4.2 7500 REAL-TIME INSTRUMENT WJRIFICA%&N

4.2.1 Set up the Driftcon by coéaéc§sﬁg the hardware
module to the computer%@j 6@ fj%ture/probe plate
ey .
N

with the provided ca
AN

%)
4,2.,2 Insert the smart QS%d 25k2<§§§ Driftcon hardware

module until it Qtops\g) C)
@ \&
4.2.3 Turn on thgggbiftéyn Qigguter. Open the Driftcon
1

Software a {3} the appropriate user name
and pa aa@rd\go &
Q’b $ < o
4.2.4 Turm\sh t ) computer, login with the
ap, pri@te r name and password, and open the
0
g&g

5 ware.,

4.2(??'Turn on the 7500. Remove the tray from the plate
{S) loader and replace it with the FFC adaptor. Place
<2 the fixture into the adaptor with the cable facing
out. Place the cork leveler on top of the fixture
and close the plate loader.

4.2.6 In the 7500 SDS software, choose File > New and
select Absolute Quantitation for Assay, 96-Well
Clear for Container, and Driftcon for Template.

4.2.1 Save the plate document as a .sds file with the
appropriate plate name and open the Instrument
tab.
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4,2.8 In the Driftcon software, choose the instrument to
be tested. If the list of instruments does not
appear automatically, click start and follow the
wizard prompts.

4.2.9 Choose the Driftcon default protocel and make sure
the steps match those in the 7500 protocol. Leave
the humidity, pressure, and temperature blank.
Enter notes as needed (these will appear on the
final report).

9

4.2.108tart the 7500 run and Driftcon test(ﬁabtart the
test by clicking the check mark in e lower right
corner, Make sure the 7500 has Kted completely
and the protocol started befor arting the test,
The protocol will complete 193\ 5 min.

4.2.11The analyst need not be nce the test has
started; however, addl éﬁ;s /information are
available during the Jtﬁ eﬁis g the F6 key
for a surface viewy ﬁeat nt), F7 for
measurement valu \T al time)}, and F8
for measurement oc che wells) .

4.2.120nce the rggt' s E§mp d, print the report and
place it 1 h n er. Connect to the printer
\\<<'>

as foll
Qﬁbck(éh& Computer’
é !(\ '>'Device Manager’
Q\ el WOrk Adaptors’
{h’ Double 1ck ‘Intel (R) PRO/Wireless LAN 2100 3A
Mini PCI Adaptor’
. Open the ‘Wireless Network’ tab
. Click the ‘Security’ button and change the Data
Encryption to 64 bit from the dropdown menu
g. Fnsure that the ssid is Linksys
h. Click ‘0K’ and close all windows

@Q

Hh

%

4.0 Comments

4,1 The second page of the report contains information
regarding the number of measurements for each probe.
The number should be approximately double the protocol
time. If significantly higher or lower, the
instrument may be heating too slowly or too quickly.
The percentage should be 100% for each probe. If a
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percentage is lower than 100%, the probe may not have
been in the well and measurements missed. Adjust the
probes and run the protocol again.

5.2 Pass/better than specifications/fail data may be found
beginning on page four, for each temperature, The
measured value, along with the target specifications
are shown in this section.

9
&
%Q}
é\O
\QQ Q*
C L
. QQ Q\'
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